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OPERATOR MANUAL

2400 Compounder



SYMBOLS ON THE COMPOUNDER 

 
Power button 

 
Power light 

 
Load cell 

 
Display 

 

Pump door must be closed to operate 
 

Warning / Caution 

 USB port  Ethernet port 

 
Reset button 

 

Protective ground 
(earth) terminal 

 

WARNING! US federal law restricts this 
device to sale, distribution and use by 
or on order of a physician. 

 Fuse 

 

TERMS IN THIS MANUAL 

 

WARNING 

Indicates a risk of personal injury or patient harm if the instructions are not followed 

 

 

CAUTION 

Indicates a risk of damage to equipment or data if the instructions are not followed 

 

IMPORTANT! Provides important information 

NOTE: Provides additional information 

Tip! Provides a recommendation 

 

In the electronic version of this manual, underlined text and Table of Contents entries provide 
hyperlinks to other sections. 
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INTRODUCTION 

The Baxa EXACTAMIX 2400 Compounder is an automated pumping system that compounds 
multiple sterile ingredients into a finished solution in a single patient bag. Using a formula 
provided electronically or entered manually, the compounder withdraws a specified volume of 
each ingredient from its source container in a specified sequence, and pumps each ingredient 
into a patient bag. The finished solution is delivered to patients intravenously. 

You can use the compounder to compound solutions such as: 

 Parenteral Nutrition (PN) 

 Continuous Renal Replacement Therapy (CRRT) 

 Cardioplegia 

 Base solutions 

 Epidurals 

 

WARNING 

The compounder software is not intended to replace the professional judgment or 
knowledge of a pharmacist or pharmacy technician. 
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COMPONENTS 

HARDWARE COMPONENTS 

The compounder consists of these main hardware components: 

 

Hardware components 

NOTE: The optional vial rack extension and printer are not shown.  

Vial rack 

Load cell 

Barcode reader 

Main module 

Display 

Base plate 
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The main module contains the moving parts of the compounder, including these parts: 

 The valve actuators open and close as needed to allow the delivery of individual 
ingredients. When the pump is paused, the valve actuators automatically close. 

 The occlusion detector detects occlusions (blockages) in the tube between the source 
containers and the detector. 

 The bubble detector detects air bubbles as they pass through the tube over the 
detector. 

 The pump door allows access to the pump rotor. 

 The pump rotor moves the fluid from the valve set to the destination bag. 

 

Main module, with close-up view of the top 

Pump rotor 

Bubble detector 

Occlusion detector 

Pump door 

Valve actuators 
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The load cell weighs each destination bag 
and sends this measurement back to the 
display, where calculations are performed. 
A 2,000 g calibration weight is provided with 
the compounder and used to calibrate the 
load cell. 

 

Load cell 

The display operates the compounder 
software and includes a touch screen for 
easy input. The bottom of the display 
contains USB ports that can be used to 
connect a barcode reader, keyboard, mouse, 
and printer or USB drive. The bottom of the 
display also contains one Ethernet port. 
A reset button is also available if needed. 

 

Display 

The barcode reader is stored on the right 
side of the display. This reader is used to 
scan barcodes on the labels of source 
containers, inlets and patient bags. 

Models of the barcode reader may vary. 

 

Barcode reader 
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The vial rack attaches to the main module 
and can support an optional vial rack 
extension. Adjustable vial holders and 
syringe holders attach to the vial rack. 

 

Vial rack 

The base plate is the common base on which 
the compounder’s components sit. 
 

 

Base plate 

The optional laser printer, used for printing 
reports and labels, can be connected directly 
to the compounder or to a network. 

Models of the printer may vary. 

 

Printer 
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DAILY USE COMPONENTS 

 The valve set is a sterile, multiple-port valve with an outlet tube attached. The valve 
body fits over the valve actuators on the compounder, protecting them from damage. 
The outlet tube attaches to the destination bag. For ordering information, refer to Valve 
Sets on Page 16. 

 The inlet is a sterile tube with a spike or Luer end attached. The spike or Luer end 
attaches to a source container, and the other end attaches to a port on the valve set. 
The type of inlet that is used depends on the source container. For inlet types, 
descriptions and ordering information, refer to Inlets on Page 15. 

NOTE: The valve set and inlets are collectively known as the tube set. 

 The destination bag is a sterile container that holds the fluid pumped from the source 
containers. There are two main types of destination bags, which are available in 
different sizes. For bag types, descriptions and ordering information, refer to Bags on 
Page 16. 

 The patient bag is used for delivering the finished solution to a patient. This bag 
contains three ports for filling the bag, adding ingredients manually and 
delivering the finished solution.  

 The calibration bag is used for collecting any fluid that is not intended for a 
patient. For example, this type of bag is used while calibrating and priming the 
compounder. This bag contains only one port for filling the bag. 

 
 

  

Valve set Inlet 
Patient  

bag 
Calibration  

bag 



Components 

Operator Manual for the Baxa EXACTAMIX 2400 Compounder 
5300-0769 Rev. P Page 7 

SOFTWARE 

The compounder has been validated and approved for use only with the software that Baxa 
Corporation provides. 

License 

The license to use the compounder software is granted to a single concurrent user on a single 
EXACTAMIX 2400 Compounder for the term of the equipment contract. Baxa Corporation 
retains ownership of the software. Distribution or copying of this software, other than for 
backup purposes, is expressly forbidden.  

Permissions 

The options that appear in the software depend on the permissions granted to the user. If you 
have questions about your permissions, contact your supervisor. For more information about 
setting up permissions, refer to Setting Up the Users on Page 121. 

Navigation 

On any screen or window that requires data entry, touching a field displays an on-screen 
keyboard or number pad that allows you to enter characters. 

 

 

On-screen keyboard and number pad 
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Menu Screen 

The menu screen allows access to menus and settings. 

 

Menu screen 

The menu screen has six tabs at the top. Touching a tab displays a drop-down menu. Use the: 

 File menu to log out of the software, exit the software, restart the compounder and 
shut down the compounder 

 Edit menu to view and edit the configurations, formulary, ingredient groups, inlet 
information and bag information 

 Compound menu to set up the compounder for operation, select a formula to 
compound and execute the options in the Setup Wizard independently 

 Tools menu to set up options related to the system, users, security, directories used for 
saving certain files and software maintenance 

 Reports menu to view, print and export reports related to compounding and other 
device activity 

 Help menu to view tutorials and information about the hardware and software 

Touching Close in the bottom right displays the pump screen. 
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Pump Screen 

The pump screen shows a diagram of the valve set. It is used during the compounding process. 
Similar screens are used during setup. 

 

Pump screen at the start of the compounding process 

The appearance of the pump screen changes slightly during various steps of the compounding 
process. However, the screen always includes these elements: 

 The formula name and serial number appear on the top of the screen. 

 Buttons appear on the left side of the screen. Touching Run starts the compounding 
process. Touching Menu displays the menu screen. 

 The total volume to be pumped for the order appears under the Menu button.  

 A diagram of the valve set with numbered ports appears on the middle of the screen. 
Ports that: 

 Have no ingredient attached have an X over them 

 Have an ingredient attached have an ingredient button connected 

 Have the Universal Ingredient (UI) attached are identified by a U 

 Make up an electronic Y-site are identified by colored highlighting 



Components 

Operator Manual for the Baxa EXACTAMIX 2400 Compounder 
Page 10 5300-0769 Rev. P 

 

Ingredient button 

On the pump screen, each ingredient button includes: 

 The abbreviated ingredient name 

 The port number 

 A green check mark indicating that the inlet and port have been verified, or a red X 
indicating that they need to be verified 

 The ordered volume of the ingredient 

 A number indicating the ingredient’s place in the compounding sequence 

 A light blue, vertical bar showing how much of the ingredient remains in the container; 
during the compounding process, this bar decreases as the remaining volume decreases 

 A dark blue, horizontal bar showing how much of the ingredient is being used for the 
current order; during the compounding process, this bar increases as the pumped 
volume increases 

When an ingredient is being pumped, its button becomes yellow. An animation shows fluid 
moving through the inlets and the outlet tube into the destination bag. Horizontal marks across 
an inlet represent fluid, indicating that this inlet has been primed. 

Port number 

Green check mark 

Ordered volume 
Ingredient status bar 

Number in sequence 

Pumping progress bar 

Abbreviated ingredient name 
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FEATURES 

SUMMARY OF FEATURES 

The compounder: 

 Accepts formulas created by order-entry software on a separate computer, or by direct 
entry on the compounder 

 Uses barcodes on the source containers and inlets to promote correct setup 

 Includes software with a Setup Wizard to guide you through the setup process 

 Supports a maximum of 24 ingredients, source containers in volumes of 0.2–5,500 mL 
and destination bags in volumes of 125–5,000 mL in Europe or 250–5,000 mL for all 
other regions 

 Allows you to attach the same ingredient to more than one port, creating an electronic 
Y-site 

 Allows you to specify the sequence in which ingredients are pumped 

 Allows you to specify the accuracy limits for the finished solution 

 Uses volumetric delivery, gravimetric verification and automatic calibration to help 
ensure delivery accuracy 

 Uses a bubble detector and occlusion detector 

 Can be immediately stopped by lifting the pump door 

 Can track ingredient lot numbers and ingredient expiration dates 

 Generates a MixCheck Report for each finished solution 

 Can print reports and barcode labels at the compounder’s printer 

 Can be set up to communicate with the printer and retrieve orders through a network 

ORDER ENTRY 

The operating software can retrieve orders, via a network, from order-entry software on a 
separate computer. The order-entry software must produce a .PAT file and typically produces a 
corresponding barcode. At the compounder, scanning the barcode or manually selecting the 
formula retrieves the .PAT file through the network. The compounder also has other options for 
order entry when the order-entry computer or network is unavailable. For more information, 
refer to Loading the Formula on Page 73. 

FORMULARY 

The formulary is the list of ingredients, and associated products, which can be attached to the 
compounder. 

An ingredient is a solution of a specific chemical entity at a specific concentration regardless of 
container size, container type or manufacturer. One ingredient can have several associated 
products.  
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A product is an ingredient in a particular container size and type from a specific manufacturer. 
Several products can be associated to one ingredient. 

For example:  

 Ingredient: Amino Acid 70%  

 Products:  

 Manufacturer X Amino Acid 70%, 2000 mL bag  

 Manufacturer X Amino Acid 70%, 1000 mL bag  

 Manufacturer X Amino Acid 70%, 500 mL bottle  

 Manufacturer Y Amino Acid 70%, 2000 mL bag  

 Manufacturer Y Amino Acid 70% 1000 mL bottle  

INGREDIENT GROUPS 

An ingredient group is a list of chemically similar ingredients. For example:  

 Ingredient Group: Phosphate  

Ingredients: K Phos 3mM/mL, Na Phos 3mM/mL  

 Ingredient Group: Calcium  

Ingredients: Ca Gluconate 10%, Ca Chloride 10%  

Some ingredients can tolerate each other’s presence in the finished solution, but must be 
separated during compounding to ensure that they do not mix within the common fluid 
pathway, or within the patient bag in the absence of sufficient volume. These ingredients are 
considered to be incompatible. For example, calcium and phosphate should not be mixed in 
their concentrated forms (in the absence of amino acids), or a precipitate will immediately 
result. The compounder will pump incompatible ingredients only if it can pump a user-specified 
volume of another ingredient between them. 

Each ingredient group has a list of other groups with which it is incompatible. When ingredients 
are assigned to these groups, the software can detect formulas in which incompatible 
ingredients are not sufficiently separated.  

UNIVERSAL INGREDIENT (UI) 

When a patient bag is removed, approximately 25 mL of the last ingredient pumped remains in 
the common fluid pathway. This ingredient then becomes the first ingredient to enter the next 
patient bag when the next solution is compounded. Because this ingredient must be suitable 
for all formulas, it is called the Universal Ingredient (UI). 

Each formula must include enough Universal Ingredient volume to allow a final flush, which 
flushes all the previous ingredients into the patient bag. Regardless of the total volume of the 
Universal Ingredient to be delivered, the compounder reserves enough volume of this 
ingredient to perform a final flush at the end of the compounding process. You can change the 
volume used for the final flush when creating a configuration. However, the volume must be at 
least 25 mL. 
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The Universal Ingredient is specified by the facility and is typically sterile water for injection 
(SWFI). 

CONFIGURATION 

A configuration identifies the products that will be attached to the ports, the sequence in which 
they will be pumped, any allowable auto-additions, the ingredient and volume to use for any 
ingredient flushes, the Universal Ingredient and the volume to use for the final flush. 

BARCODE VERIFICATION 

 

WARNING 

It is important to use a barcode reader for scanning barcode labels on source 
containers and inlets during verification of the setup.  

For the barcode verification to be effective, it is critical that the configuration be set up 
correctly. For instructions, refer to Attaching the New Ingredients and Inlets on 
Page 45. 

During daily setup, or when a source container must be replaced, the software guides you 
through a process of barcode verification. You scan a barcode label on each inlet and each 
source container to verify that the inlet is attached to the correct container. 

Each inlet must be labeled with a barcode that identifies the port to which the inlet is attached. 
These barcode labels are packaged with the valve set. The compounder software can also 
generate a report that makes these labels available for printing. 

Most source containers already have a manufacturer’s barcode label attached. For containers 
that are filled or diluted in the pharmacy, the compounder software can also generate a report 
that makes these labels available for printing.  

Tip! Baxa Corporation strongly recommends using the manufacturer’s barcode labels whenever 
possible. 

DELIVERY AND ACCURACY 

The compounder uses volumetric delivery to move fluid, with gravimetric verification to check 
the final weight of the destination bag. The compounder also performs an automatic calibration 
to maintain delivery accuracy. 

Volumetric Delivery 

The pump rotor moves as it pumps an ingredient into the destination bag. The amount of 
movement determines the volume that is delivered.  

Flow Factors and Calibration 

The pump is calibrated with sterile water. A flow factor associated with each ingredient adjusts 
the flow of that ingredient compared to the flow of water. The flow factor accounts for the 
ingredient’s viscosity, the size and type of its source container, its inlet, its venting and other 
factors that affect its delivery. As a result, calibrating with water automatically calibrates the 
compounder for use with all the other ingredients. 
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The pump is calibrated during daily setup. In addition, when the rotor pumps an uninterrupted 
delivery of 175 mL or more of water, the compounder automatically performs a calibration of 
the rotor movement. Automatic calibration maintains the rotor’s accuracy and reduces the 
need for manual adjustments.  

Gravimetric Verification 

The compounder provides feedback about its delivery accuracy by weighing the finished 
solution and comparing that weight to the theoretical weight of a perfectly compounded 
solution. This theoretical weight is computed by this formula: 

 

PRINTING OPTIONS 

The printer is used for printing reports and creating labels for inlets and source containers. 
The printer can use standard 8.5 x 11 in. (21.6 x 28 cm) or A4 paper and standard label sheets. 
Avery 5160 label sheets are recommended. 

You can connect the printer to a: 

 USB port on the display 

 USB port on the order-entry computer for use on a network, if the facility provides a 
network-ready printer 

 Network via an Ethernet cable, if the facility provides a network-ready printer 

The compounder software includes the printer drivers for the printer provided by Baxa 
Corporation only.  

NETWORK CONNECTIVITY  

You can connect the compounder, via an Ethernet cable, to a: 

 Facility network 

 Mini-net that is typically shared only with the order-entry computer 

The compounder reaches out to the network only to retrieve .PAT files, send print jobs and 
back up the database. 

Baxa Corporation does not support activity related to setting up or troubleshooting the facility’s 
network. 

Tip! If you connect the compounder to a network, Baxa Corporation recommends taking 
precautions to minimize the compounder’s exposure to cyber threats. For example, use a 
router that acts as a firewall or a VLAN. For more information about network security, contact 
Baxa Corporation Technical Support. Refer to Getting Help on Page 17. 
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ORDERING SUPPLIES 

Order supplies through your normal channels.  

 

WARNING 

Use only sterile inlets, bags and valve sets validated by Baxa Corporation. 

INLETS 

The following inlets are available. Availability may vary by region. 

Product 
Order 

Number 
Quantity / 

Case 
For Use With 

Standard  
Priming  
Volume 

Minimum  
Priming  
Volume 

Non-Vented High-
Volume Inlet  

H938173 25 Large-volume, vented or collapsible 
containers (such as bags of dextrose 
and water) 

50–60 
mL  

25–30 mL 

Vented High-Volume 
Inlet 

H938174 25 Large-volume, non-vented 
containers that require a spike to 
vent air into the container, such as 
bottles 500 mL or larger 

50–60 
mL 

25–30 mL 

Vented Micro-
Volume Inlet 

H938175 25 Small-volume vials, 10–250 mL 5–6 mL 2.5–3 mL 

Vented or Non-
Vented Micro-
Volume Inlet, with 
Large-Bore Spike 

H938751 25 Small-volume bags or bottles that 
require a large-bore spike 

5–6 mL 2.5–3 mL 

Syringe Inlet H938176 25 60 mL Luer syringes (regardless of 
the volume they contain) 

5–6 mL 2.5–3 mL 

Baxa Corporation inlets are sterile, bio-compatible, non-pyrogenic, non-DEHP and contain no 
natural rubber latex components. 

NOTE: The compounder will automatically use the highest available value for the standard 
priming volume and half of that value for the minimum priming volume. However, you can 
adjust these priming volumes in the Inlet Editor. For instructions, refer to Using the Inlet Editor 
on Page 150. 
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BAGS 

The following bags are available. Availability may vary by region. 

Product 
Order  

Number 
Quantity /  

Case 
Notes 

EXACTAMIX Empty EVA Container, 
250 mL 

H938737 50  

EXACTAMIX Empty EVA Container, 
500 mL 

H938738 50  

EXACTAMIX Empty EVA Container, 
1000 mL 

H938739 50  

EXACTAMIX Empty EVA Container, 
2000 mL 

H938740 50  

EXACTAMIX Empty EVA Container, 
3000 mL 

H938741 50  

EXACTAMIX Empty EVA Container, 
4000 mL 

H938742 50  

EXACTAMIX Empty EVA Container, 
5000 mL 

H938143 50  

EXACTAMIX Empty EVA Container, 
dual chamber, 1500 mL 

H938901 42  

EXACTAMIX Empty EVA Container, 
dual chamber, 3000 mL 

H938905 42  

EXACTAMIX Empty EVA Calibration 
Bag, 1000 mL 

H938735 50 Can be used for functions other than 
calibration; refer to calibration bag on 
Page 6 

Tamper-resistant add-port cap H9384858 100 Not compatible with dual-chamber bags 

Baxa Corporation bags are sterile, bio-compatible, non-pyrogenic and contain no natural rubber 
latex components. These bags have a large-bore, threaded fill-port connector. 

VALVE SETS 

The following valve sets are available. Availability may vary by region. 

Product Order Number Quantity / Case Notes 

EM2400 Valve Set H938724 10 Includes: 

 Numbered inlet labels with barcodes  

 10 calibration bags (H938735) 

Baxa Corporation valve sets are sterile, bio-compatible, non-pyrogenic, non-DEHP and contain 
no natural rubber latex components.  
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GETTING HELP 

The contact information and hours for Baxa Corporation Technical Support vary by region. 
Support in English is available 24 hours/day, 7 days/week at 800.678.BAXA (2292), 
303.690.4204 or cotechsupport@baxter.com. 

Before you call or e-mail for technical support: 

1. At the menu screen, touch Help > About.  

The About window appears. It provides information about the hardware and software.  

2. At the About window, identify the Operating Software Version and Build #. 

 

 

About window 
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INSTALLING THE COMPOUNDER 

Your Baxa Corporation service provider will install the compounder at your site.  

If you must reinstall the compounder or replace a component, verification tests must be 
performed before you use the compounder again. Contact Baxa Corporation Technical Support 
for assistance. Refer to Getting Help on Page 17. 

To start, open the packaging, remove all the items and inspect them to make sure that they are 
not damaged. 

 

WARNING 

Do not use sharp objects to open the packaging. Personal injury may result. 

The compounder should be placed on a level and stable surface to prevent its 
modules from moving out of position. Always hold the modules as shown below to 
avoid dropping them.  

1. Route the power cord out through the routing hole in the back of the main module. 
2. Place the main module onto the base plate. 

 

Placing the main module 

3. Place the load cell to the left of the base plate. 
4. Place the display to the right of the base plate. 
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5. Tip the main module back and extend the support legs.  

 

Extending the support legs 

NOTE: In a small hood, there may not be enough space behind the main module to tip it 
back. To make more space, you can move the compounder forward by lifting the front 
of the base plate slightly and sliding it toward you. It is easier to slide the base plate on 
its back feet (which are plastic) than on its front feet (which are rubber). 

 

WARNING 

Using the support legs will reduce the possibility of pinching your hands when 
you connect the cord and cables. 

The power cord must be unplugged from the main AC power source whenever 
you connect or disconnect the display and load cell. 

The power cord must be positioned so that the plug is easily accessible. 

Support legs 
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6. Under the main module, connect the following cord and cables. Reach under the main 
module with your palm facing up. 

a. Connect the power cord. 
b. Connect the cable for the display. Align the connector over the port on the main 

module, then push firmly on the connector to connect it. Check the connection 
by pulling on both sides. 

c. Connect the cable for the load cell. Align the connector over the port on the 
main module, then push firmly on the connector to connect it. Check the 
connection by pulling on both sides. 

 

Connecting the cord and cables 

7. Retract the support legs so that the main module rests fully on the base plate.  
8. Route the cables through the two routing holes, pushing any excess length of the cables 

through the holes. 

  

Routing a cable 

Cable for the 
display 

Power cord 

Cable for 
the load cell 
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9. Install the load cell. 
a. Ensure that the locking lever is unlocked by sliding it forward. 
b. Place the load cell onto the base plate. 
c. To lock the load cell, move the black lever back until it clicks into place. 

 

Installing the load cell 

10. Install the display onto the arm.  

The white locking pin snaps into the locked position.  

 

Installing the display 

NOTE: You can remove the display by pulling the locking pin out to the unlocked 
position, then rotating the pin 90 degrees to keep it in this position while lifting the 
display. 
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11. Install the barcode reader. 
a. Pull the arm that is behind the display out to the right. 
b. Rotate the arm up and over toward you. 
c. Pull the arm slightly to the right to lock it into place. 

 

Rotating the arm 

d. Place the barcode reader in the cradle with the trigger facing you. 

 

Placing the barcode reader 
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12. Connect the USB cable from the barcode reader to a USB port on the bottom of the 
display.  

13. If desired: 

 Connect the USB cable from the printer to a USB port on the bottom of the display. 

 Connect an Ethernet cable to the Ethernet port on the bottom of the display. 

NOTE: To perform administrative work, you can also connect a keyboard and mouse to 
the USB ports on the display. The keyboard and mouse should not be connected during 
normal compounding operation. They will conflict with the barcode reader, causing it to 
function incorrectly. 

14. Move the arm of the display to the desired position. 
a. Unlock the lever on the right by rotating it forward. 

NOTE: Pulling the lever slightly out to the right allows adjustment of the lever’s 
position if needed. 

b. Adjust the arm of the display forward or backward. 
c. Lock the lever by rotating it backward. 

 

Lever on the right 

Lever 
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15. Move the display to the desired position.  
a. Unlock the lever on the left by rotating it backward. 

NOTE: Pulling the lever slightly out to the left allows adjustment of the lever’s 
position if needed. 

b. Adjust the display up or down. 
c. Lock the lever by rotating it forward. 

 

Lever on the left 

16. Check that the cables: 

 Are not kinked or pinched 

 Do not touch the base of the load cell 

17. Plug the power cord into an uninterruptible power supply (UPS). 
18. Install the vial rack onto the back of the main module. On each end, slide the slot on the 

vial rack over the bolt on the main module. 

 

Installing the vial rack 

Lever 
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19. Install the vial holders in the desired locations on the vial rack. 
20. Adjust the position of each top and bottom vial holder. 

a. Rotate the cam up to the unlocked position. 
b. Push the holder to the desired location on the pole. 
c. Rotate the cam down to the locked position. 

 

Adjusting the vial holders 

 

Cam unlocked 

Cam locked 

Pole 

Top vial holder 

Bottom vial holder 
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STARTING UP, LOGGING IN AND OUT, AND SHUTTING DOWN 

STARTING UP AND LOGGING IN 

1. On the main module, press and hold the power button until the power light illuminates. 

 

Power light and power button 

2. If the software does not start automatically, double-touch the Exacta-Mix 2400 icon on 
the Windows desktop. 

Tip! Baxa Corporation recommends setting the software to start automatically. Contact 
Baxa Corporation Technical Support for assistance with setting up this feature. Refer to 
Getting Help on Page 17. 

 

Icon 

3. If the Login window appears: 
a. Enter a Login name. 
b. Enter a Password. 
c. Touch Log In. 

 

Login window 

Power light 

Power button 
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Tip! Baxa Corporation recommends setting up each user with a unique login name and 
password. If the compounder is connected to a network, Baxa Corporation requires that 
the compounder be logged in to the network automatically. For details, contact Baxa 
Corporation Technical Support. Refer to Getting Help on Page 17. 

NOTE: To require each user to log in, refer to General on Page 117. To set up password 
expiration, refer to Password Expiration on Page 118. 

When the software starts, it performs self-checks and briefly displays the following 
messages. Other messages may also appear. Do not cancel these operations. 

   

Messages that appear at startup 
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Next, the software may display a Confirm screen. Several styles of the Confirm screen may 
appear, but each includes this text: Compounder is not ready for operation. Do you wish to 
run the setup wizard? The screen also lists the conditions that prevent the compounder from 
being ready for operation. The screen appears if any of these conditions exist: 

 The calibration of the load cell has expired (at midnight). 

 The calibration of the pump has expired. 

 The tube set has expired. 

NOTE: To set up the options for tube set expiration, refer to Tube Set Expiration on 
Page 114. 

 

Confirm screen 

4. If the Confirm screen appears: 

 Touch Yes if you want to use the Setup Wizard now. For instructions on using the 
Setup Wizard, refer to Setting Up the Compounder on Page 31. 

 Touch No if you want to continue using the software in the current state. 

Tip! Baxa Corporation recommends always touching Yes. If you touch No, you 
will be instructed to perform any required setup steps before compounding. 
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LOGGING OUT 

When you have finished using the compounder, or another user needs to log in, you should log 
out of the software.  

At the menu screen, touch either: 

 File > Logout 

 Tools > Users > Change User 

NOTE: The Confirm screen may appear if the compounder is not ready for operation. To set up 
the automatic logout option, refer to Auto-Logout on Page 117. 

REBOOTING AND SHUTTING DOWN 

Tip! Baxa Corporation recommends shutting down the compounder when you are finished 
using it. Baxa Corporation also recommends fully shutting down and starting up the 
compounder, or rebooting it, once a day to allow the software to perform routine database 
maintenance.  

1. At the menu screen, touch File > Exit. 

The Exit Options window appears. 

 

Exit Options window 

IMPORTANT! The last two options shown above require Administration permissions. For 
more information about user groups and permissions, refer to Setting Up the Users on 
Page 121. 
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2. Touch one of these options: 

 Shutdown the computer? to shut down the software and turn off the compounder 

 Reboot the computer? to shut down the software, turn off the compounder and 
restart the compounder 

 Log on as a different user? to log out and allow another user to log on 

NOTE: The Confirm screen may appear if the compounder is not ready for operation. 

 Minimize this application? to minimize the compounder software so that the 
Windows desktop is visible 

NOTE: The compounder software remains active and can be maximized when 
needed.  

 Exit program? to exit the compounder software 

3. Touch OK. 
NOTE: You cannot turn off any part of the compounder by pressing the power button on the 
main module. This button is used only to turn the power on. Shutting down the compounder is 
done through the software. If you are unable to shut down through the software, you can 
reboot the display by pressing and holding the reset button on the display. 

 

CAUTION 

There is a reset button on the bottom right of the main module. Do not press this 
button at any time other than when you are directed by Baxa Corporation Technical 
Support. This action can corrupt the database. 
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SETTING UP THE COMPOUNDER 

ACCESSING THE SETUP WIZARD 

The Setup Wizard guides you through the setup process.  

You can access the Setup Wizard in two ways: 

 Touch Yes at the Confirm screen if it appears during startup.  

 Touch Compound > Setup Wizard at the menu screen to access the Setup Wizard at any 
time. 

NOTE: The Compound menu also includes options that allow you to perform individual steps of 
the setup process without completing the entire Setup Wizard. 

Tip! Baxa Corporation recommends always using the Setup Wizard to guide you quickly through 
the necessary steps in the correct sequence. 

 

Menu screen, Compound menu 
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IMPORTANT! These functions require Compounder permissions. For more information about 
user groups and permissions, refer to Setting Up the Users on Page 121. 

The Setup Wizard guides you through these main steps:  

1. Calibrate Load Cell guides you through calibrating the load cell. 
2. Select Configuration allows you to select a configuration to use. 
3. Change Tube Set guides you through installing a new tube set and new ingredients for 

the selected configuration. 
4. Prime and Verify guides you (and an optional cosigner) through the process of priming 

the inlets and verifying the setup. 
5. Calibrate Compounder calibrates the compounder’s pump to ensure that it will deliver 

the intended volume of each ingredient. 
6. Authorization Report allows you to view and print the Authorization Report, if desired. 

 

Setup Wizard screen 
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CALIBRATING THE LOAD CELL 

This procedure calibrates the load cell to ensure that it measures weight accurately. 

The load cell must be calibrated: 

 Daily, after the calibration expires at midnight 

 Using a 2,000 g weight that Baxa Corporation provides 

Tip! Baxa Corporation recommends: 

 Using gloves to handle the weight, to minimize the accumulation of oils and dust 

 Storing the weight in its storage case 

To calibrate the load cell: 

1. At the Setup Wizard screen, touch Calibrate Load Cell.  

 

Setup Wizard screen, calibrating the load cell 

NOTE: To calibrate the load cell without using the Setup Wizard, you can touch 
Compound > Calibrate Load Cell at the menu screen. 
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The Load Cell Calibration Requested message appears. 

 

Message 

IMPORTANT! If any items touch the load cell during the calibration, the calibration will 
not be accurate. 

2. Make sure that: 

 There is no weight on the load cell. 

 There is nothing touching any part of the load cell (for example, there are no cables 
touching the base). 

3. At the Load Cell Calibration Requested message, touch OK.  

This message appears and then disappears: 

 

Message 

The Place Calibration Weight message appears.  

 

Message 
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4. Place the 2,000 g weight on the load cell, aligning it with the holes in the load cell. 

 

Aligning the calibration weight 

5. At the Place Calibration Weight message, touch OK.  

This message appears and then disappears: 

 

Message 

When calibration is finished, one of these results occurs: 

 If you accessed the calibration procedure from the Setup Wizard screen, you return 
to that screen, and a check mark now appears next to Calibrate Load Cell. 

 If you accessed the calibration procedure directly from the Compound menu, a Load 
cell calibration complete message appears.  

 

Message 

6. If the Load cell calibration complete message appears, touch OK. 
7. Remove the calibration weight. 
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SELECTING THE CONFIGURATION 

The configuration identifies which ingredients are attached and at which ports on the 
compounder. 

The software automatically selects the last configuration that was used, and a check mark 
appears next to Select Configuration. 

You must manually select the configuration only if both of these conditions exist: 

 More than one configuration is available. 

 You want to use a configuration that is different from the last one that was used. 

If you want to select the configuration manually: 

1. At the Setup Wizard screen, touch Select Configuration. 

 

Setup Wizard screen, selecting the configuration 

NOTE: To select the configuration without using the Setup Wizard, you can touch 
Compound > Select Configuration at the menu screen. 

The Select Configuration screen displays the last configuration that was used. 
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2. In the Name list, select the desired configuration. 
3. Touch OK. 

 

Select Configuration screen 
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CHANGING THE TUBE SET 

If the tube set is expired, it must be changed during the daily setup. 

NOTE: To set up the options for tube set expiration, refer to Tube Set Expiration on Page 114. 

 

WARNING 

To maintain delivery accuracy, the tube set must be replaced after it has delivered 
150 L of fluid or been installed for 24 hours, whichever comes first. 

Check that the materials of the inlets, valves and bags are compatible with all 
ingredients used. Contact the ingredient manufacturer to confirm compatibility. 

Checking the Tube Set Statistics 

1. At the Setup Wizard screen, touch Change Tube Set. 

 

Setup Wizard screen, changing the tube set 

NOTE: To change the tube set without using the Setup Wizard, you can touch 
Compound > Change Tube Set at the menu screen. 
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A screen with tube set statistics and recommendations appears. The statistics show how 
long the current tube set has been installed and how much fluid has been pumped 
during that time. Based on the usage, the software recommends whether or not the 
tube set should be changed. 

 

Tube set statistics and recommendations 

2. Touch one of these options: 

 Touch Tube set will be changed, then continue with Removing the Expired Tube Set 
and Expired Ingredients on Page 40. 

NOTE: Selecting Tube set will be changed resets the expiration counter for the tube 
set and resets the ingredient remainders (values in the software that represent the 
actual volume of fluid remaining in the source containers). 

 Touch Continue with current tube set. 

NOTE: Selecting Continue with current tube set does not reset the expiration 
counter or the ingredient remainders. 
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Removing the Expired Tube Set and Expired Ingredients  

 

CAUTION 

Do not remove the valve set until you have removed all the source containers. 
This precaution helps to prevent a dropped source container from damaging the 
valve actuators. 

If an expired tube set and expired ingredients are already installed: 

1. Attach a calibration bag. Refer to Attaching and Removing the Calibration Bag on 
Page 43. 

2. Does the facility require the inlet spikes to be removed from the source containers? 

 If yes, continue with the next step. 

 If no, remove the source containers from the vial rack and the hangers. Place the 
source containers into a waste container, according to your facility's protocol. Then 
skip to Step 8. 

NOTE: Do not disconnect the inlets from the source containers or the valve set. 

3. Remove one source container from the vial rack or hanger, and turn the container right 
side up.  

4. Lower the container below the height of the valve set, and allow the fluid in the inlet to 
flow back into the source container. 

5. Remove the inlet from the port on the valve set. 
6. Discard the source container and the attached inlet according to your facility’s protocol.  
7. Repeat the previous steps for each source container, until all the source containers and 

inlets are discarded. 
8. Open the pump door. 
9. Press the tabs on the ends of the valve set, then lift to remove it.  

IMPORTANT! Do not turn the pump rotor clockwise. Doing so may detach the outlet 
tube from the valve body, resulting in the spillage of fluid that is in the valve set. 

10. Remove the outlet tube from the channels near the pump rotor. Turn the pump rotor 
counterclockwise for access to the outlet tube.  

11. Remove the calibration bag. 
a. Remove the bag’s fill port from the load cell’s fill port holder. 
b. Remove the bag from the load cell. 

12. Discard the valve set and the attached calibration bag. 
Tip! Baxa Corporation recommends cleaning the compounder before installing a new valve set. 
Refer to Cleaning the Compounder on Page 100, and follow your facility’s protocol. 
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Installing the New Valve Set 

 

CAUTION 

If the valve set is not installed correctly, the compounder cannot be calibrated 
accurately. 

1. Check that the valve actuators are not broken or damaged. 

 

Valve actuators 

 

Normal 

 

Damaged 

 

Broken 

 

WARNING 

Do not use the compounder if a valve actuator is broken or damaged. Patient 
harm may result. For assistance, contact Baxa Corporation Technical Support. 
Refer to Getting Help on Page 17. 

2. Using aseptic technique, remove the valve set from the packaging.  
3. Check that all the slots on the bottom of the valve set are aligned. 

 

Checking that the slots are aligned 

4. Place the valve set onto the valve actuators.  
5. Gently push the end tabs down and out until you hear a click on each end. 

 

Installing the valve set  

NOTE: The appearance of the valve set may differ from the example shown above. 

6. Make sure that the valve set is installed securely by pulling up on both ends gently. 

 

CAUTION 

Once the valve set has been installed, do not attempt to remove it during 
operation. 

7. Open the pump door. 
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WARNING 

To avoid pinching your fingers, grasp the pump rotor from the top and rotate it 
counterclockwise, keeping your fingers away from other surfaces while moving 
the rotor. 

 

 

CAUTION 

Do not pull or stretch the outlet tube. 

8. Route the outlet tube into channel 1, around the pump rotor and into channels 2 and 3 
as shown. Move the pump rotor counterclockwise only. 

 

Routing the outlet tube 

a. Make sure that the tube is in correct position at the bottom of channels 1 and 2. 

 

Correct position 

 

Incorrect position 

b. Make sure that the tube is in correct position against the wall around the pump 
rotor. 

 

Correct position 

 

Incorrect position 

Pump rotor Outlet tube in channel 1 

Channel 3 Channel 2 
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9. Close the pump door. 
10. Connect the end of the outlet tube to the tube holder on the vial rack. 

 

Connecting the outlet tube 

Attaching and Removing the Calibration Bag 

Attach and remove the calibration bag when other procedures direct you to do so. 

To attach the calibration bag, always use aseptic technique and: 

1. Connect a sterile calibration bag to the outlet tube. 

Tip! Baxa Corporation recommends connecting the bag to the outlet tube before 
attaching it to the load cell, to prevent twisting or straining the tube. 

2. Attach the bag to the load cell. Place the holes in the corners of the bag over the guide 
pins on the load cell.  

3. Route the bag’s fill port through the load cell’s fill port holder. 
4. Make sure the outlet tube is curved, not twisted or kinked. 

  
Attaching the calibration bag to the outlet tube and the load cell 
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To remove the calibration bag, always use aseptic technique and: 

1. Remove the bag’s fill port from the load cell’s fill port holder. 
2. Remove the bag from the load cell. 
3. Disconnect the outlet tube from the bag, to allow fluid in the bag’s fill port to drain into 

the bag. 

NOTE: If the bag is not full, you may keep it in the hood to use for subsequent flushes. If 
the bag will be used again, do not clamp its fill port or discard it. 

4. If the bag will not be used again, clamp its fill port. 
5. Connect the end of the outlet tube to the tube holder on the vial rack. 
6. Cap the bag’s fill port. 
7. Discard the bag. 

Preparing the New Ingredients 

 

WARNING 

The compounder is not for use with non-sterile containers. 

Source containers that can be used with the compounder are: 

 Bags 

 Bottles, vented or non-vented (500 mL or larger) 

 Vials (10–250 mL) 

 Luer syringes (60 mL only) 

If you plan to use a different syringe size, contact Baxa Corporation Technical Support. Refer to 
Getting Help on Page 17. 

1. Gather all the new ingredients. 

Tip! Baxa Corporation recommends using the Authorization Report to quickly identify 
the ingredients needed for a specific configuration. Refer to Authorization Report on 
Page 159. 

2. Check that each source container has a barcode label attached. 

Tip! Baxa Corporation strongly recommends using the manufacturer’s barcode labels 
whenever possible. 

3. If a container that was filled or diluted in the pharmacy does not have a barcode label: 
a. Print the appropriate label. Refer to Product Bar Codes Report on Page 168. 
b. Apply the label.  

NOTE: To minimize curvature of the barcode, the preferred application is vertical; 
however, labels may be applied horizontally to bags and large bottles. 

Tip! When all containers are labeled, Baxa Corporation recommends that a pharmacist 
perform a final verification. 

4. If desired, a pharmacist does the following steps: 
a. Perform a final check of each container. 
b. Initial each label to show that it was checked and found to be correctly applied. 
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Attaching the New Ingredients and Inlets 

Always use aseptic technique when attaching the ingredients and inlets. 

Follow all the steps of this process for one ingredient and inlet pair before continuing with the 
next pair. This practice helps to ensure that you attach the ingredients and inlets correctly. 

Tip! To keep track of the steps, Baxa Corporation recommends working from left to right in the 
sequence of the port numbers (1, 2, 3 and so on). You might find it helpful to remember the 
main steps of this process (covered in more detail on the upcoming pages) by remembering the 
term ITASHL, which signifies: 

1. Identify the port where you will attach the ingredient. 
2. Touch the ingredient button for this port on the screen. 
3. Attach the inlet to the identified port on the valve set. 
4. Spike the source container. 
5. Hang the source container. 
6. Label the inlet with the numbered barcode label. 
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To attach an ingredient: 

1. Identify the port where you will attach the ingredient. 
a. At the Hang Source Containers screen, identify the port number. 
b. On the valve set, identify the port number specified on the screen. 

Tip! To locate an odd-numbered port, Baxa Corporation recommends locating 
the next, even-numbered port in the front row. For example, to locate port 1, 
look for port 2 in the front row and then look for port 1 directly behind it. Avoid 
leaning over the compounder. 

c. Raise and rotate the cap over this port 90 degrees, to distinguish it from the 
other ports. 

 

Raised and rotated port cap 

Raised and rotated port cap 
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2. Touch the ingredient button for this port on the screen.  

 

Hang Source Containers screen, no ingredients attached 

 

Ingredient button 



Setting Up the Compounder 

Operator Manual for the Baxa EXACTAMIX 2400 Compounder 
Page 48 5300-0769 Rev. P 

The ingredient detail window appears. 

IMPORTANT! Always view the ingredient detail window. It includes details not visible on 
the ingredient button. For example, it includes the full product description, which you 
must check. 

 

Ingredient detail window 

At the ingredient detail window, review the following information: 

 Check that the Port number is correct.  

 Check that the Product description matches the source container to be used.  

 NOTE: If desired, you can touch the arrow to the right of this field to see a list of 
similar products in the same ingredient group. If you select another product in this 
list, the Inlet type and Part # may change accordingly. 

 Check that the Inlet type and Part # are correct. 

 NOTE: The Part # shows the last three digits of the complete part number. For a list 
of complete part numbers, refer to Inlets on Page 15. The complete part number 
also appears on the packaging materials for the inlet.  

 Check that the Remainder (mL) matches the current volume of the source container. 

 NOTE: When you attach a full, unopened container, the Remainder (mL) should 
equal the volume indicated on the container. When you attach a partially full 
container, change the Remainder (mL) to the actual volume in the container. The 
compounder will use this information to help track the volume used, to alert you 
when the container needs to be changed. 

 If required, enter or check the Lot Number and the Expiration. 

 NOTE: To set up these tracking options, refer to Track Product Expiration Date and 
Lot Number on Page 113. 
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3. Attach the inlet to the identified port on the valve set.  

 

WARNING 

It is important to use the correct inlet type for the container. Using the incorrect 
inlet type can lead to occlusions and incorrect ingredient delivery, resulting in 
patient harm. 

a. Locate the inlet type specified in the ingredient detail window. Refer to Inlets on 
Page 15. 

b. Remove the inlet from its packaging materials and gently uncurl it. Do not pull or 
stretch the inlet.  

 

WARNING 

A kink that causes an occlusion in the inlet can cause the delivery of 
incorrect ingredient volumes, resulting in patient harm.  

c. Check that the inlet is not kinked. 
d. On the valve set, locate the port number specified at the ingredient detail 

window. 
e. Grasp the port cap with one hand, remove the port cap and immediately attach 

the inlet with your other hand. 
4. Spike the source container. 

 

CAUTION 

The pictures and instructions on the following pages are for reference only. 
Use correct technique as identified by your facility’s protocol. 

 To spike a bag: 
NOTE: To prevent dropping the bag, you can hang it on the hood hanger. 

a. Turn the bag with its spike port facing down. 

b. Remove the cap from the spike end of the inlet. 

 

Turning 

 

WARNING 

Failure to insert the spike completely 
into the bag port may restrict flow and 
cause the delivery of incorrect 
ingredient volumes, resulting in 
patient harm. 

c. Insert the spike fully into the bag. 

d. Rotate the spike 180° to prevent occlusions. 

 

Inserting 



Setting Up the Compounder 

Operator Manual for the Baxa EXACTAMIX 2400 Compounder 
Page 50 5300-0769 Rev. P 

 To spike a bottle: 
NOTE: To prevent dropping the bottle, you can hang it on the hood hanger. 

a. Turn the bottle with its septum facing down. 

b. Remove the cap from the spike end of the inlet. 

 

Turning 

c. Locate the shoulder of the spike. 

 

Shoulder 

d. Insert the spike fully into the bottle, up to the 
shoulder of the spike. 
NOTE: Inserting the spike up to the shoulder helps 
ensure that the maximum amount of fluid and the 
minimum amount of air is withdrawn from the 
bottle. 

 

Inserting 

Shoulder 
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 To spike a vial: 

a. Turn the vial with its septum facing down. 

b. Remove the cap from the spike end of the inlet. 

 

Turning 

c. Insert the spike fully into the vial. 

 

Inserting 

 To attach a syringe: 

a. Turn the syringe with its Luer end facing down. 

b. Remove the cap from the end of the inlet. 

c. Rotate the inlet onto the syringe. 

 

Rotating 
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5. Hang the source container. 

 

CAUTION 

The pictures and instructions on the following pages are for reference only. 
Use correct technique as identified by your facility’s protocol. 

 

 To hang a bag, hang it on the hood hanger.  

 To hang a bottle, hang it on the hood hanger. 

 

Hanging a bottle 

 To hang a vial: 

a. Push the bottom of the vial (now facing up) 
against the top holder. Make sure that the vent 
faces you.  
NOTE: If the vent faces away from you (into the 
bottom vial holder), the vial will not be seated 
securely. 

b. Slide the spiked end of the vial into the bottom 
vial holder 

 

Hanging a vial 

 To hang a syringe, hang it on the vial rack by 
snapping the syringe flanges into the syringe 
holder. 

 

Hanging a syringe 

Vent 
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6. Label the inlet with the appropriately numbered barcode label that was packaged with 
the valve set. Attach the label close to the source container. The number on the label 
must match the number of the port to which the inlet is attached. 

7. Check each inlet to make sure that it is: 
a. Not kinked 
b. Attached to the correct ingredient and port 
c. Labeled with the correct barcode label 

Tip! Baxa Corporation recommends rotating the source container so that the barcode 
label faces you, for easy scanning during barcode verification. 

8. At the ingredient detail window, touch OK. 

At the Hang Source Containers screen, the color of the ingredient button becomes teal 
to indicate that the ingredient is attached and waiting to be primed. 

 

Hang Source Containers screen, one ingredient attached 
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9. Repeat the previous steps for all the ingredients you want to attach. 

When all the ingredient buttons are teal, you are finished changing the tube set. 

10. Touch OK.  

 

Hang Source Containers screen, all ingredients attached  

If you started this procedure from the Setup Wizard screen, a check mark now appears 
next to Change Tube Set at the Setup Wizard screen. 
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PRIMING AND VERIFYING 

After the ingredients and inlets are attached, they must be primed and verified. This process 
includes scanning the barcodes on each container and inlet, priming the inlets and verifying the 
setup.  

1. At the Setup Wizard screen, touch Prime and Verify.  

 

Setup Wizard screen, priming and verifying 

NOTE: To prime and verify without using the Setup Wizard, you can touch Compound > 
Prime and Verify at the menu screen. 

 

WARNING 

It is important to use a barcode reader for scanning barcode labels on source 
containers and inlets during verification of the setup. 

2. If your facility: 

 Uses barcode verification, continue with Verifying the Ingredient and Inlet Barcodes 
on Page 56 

 Does not use barcode verification, skip to Priming the Inlets and Verifying the Setup 
on Page 59 



Setting Up the Compounder 

Operator Manual for the Baxa EXACTAMIX 2400 Compounder 
Page 56 5300-0769 Rev. P 

Verifying the Ingredient and Inlet Barcodes 

 

WARNING 

For the barcode verification to be effective, it is critical that the configuration be set up 
correctly. For instructions, refer to Attaching the New Ingredients and Inlets on 
Page 45. 

IMPORTANT! This procedure requires barcode scanning to be enabled. To enable (and, if 
desired, to require) barcode scanning for verification, refer to Bar Code Reader on Page 118. 

Tip! Baxa Corporation recommends enabling barcode scanning at all times. 

On the BAR CODE VERIFICATION screen, the ports appear empty until the barcodes on the 
attached inlets and source containers are scanned. 

 

BAR CODE VERIFICATION screen, no barcodes verified 
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WARNING 

Scan only the barcodes attached to the inlet and the corresponding source container. 
Do not scan unattached barcodes or old (used) containers. Doing so may result in 

incorrect ingredient delivery, resulting in patient harm. 

Tip! Baxa Corporation strongly recommends scanning from left to right (or from right to left) to 
prevent skipping any ports. 

1. Scan the barcode label on an inlet. 
2. Scan the barcode label on the corresponding source container. 

If you scanned the correct source container, the corresponding ingredient button 
appears on the screen. 

 

BAR CODE VERIFICATION screen 

If you scanned an incorrect source container, the compounder beeps and displays 
Incorrect scan, try again at the bottom of the screen. Confirm that the setup is correct 
and then scan the correct source container. 
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If the scanned product is not the specific product identified in the configuration but is 
the same ingredient, a Warning message appears. If the inlet must be changed, the 
message includes this instruction. Touch Yes if you want to use the scanned product. 

 

Message 

3. Repeat the previous steps until an ingredient button appears for each attached 
ingredient.  

4. At the Bar code verification completed message, touch OK. 

 

Message 
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Priming the Inlets and Verifying the Setup 

Usually, a cosigner must log in and verify the setup. Refer to your facility’s protocol. 

 

WARNING 

It is important to have a cosigner independently verify the setup, to help ensure that the 
first user attached each ingredient’s inlet to the correct port. Incorrect setup may result 
in patient harm. 

IMPORTANT! The cosignature option requires Verification permissions. For more information 
about user groups and permissions, refer to Setting Up the Users on Page 121. To require that a 
cosigner verify the setup, refer to Cosignature on Page 118. 

1. Attach a calibration bag. Refer to Attaching and Removing the Calibration Bag on 
Page 43. 

2. If the Cosignature required message appears, the cosigner should: 
a. Touch OK.  

 

Message 

b. Enter a Login name. 
c. Enter a Password. 
d. Touch Log In, then continue with the next steps. 

 

Cosignature window 
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When an X appears on the ingredient button, it indicates that verification is needed. 

 

PRIME AND VERIFY screen, no inlets primed 

 

WARNING 

Do not prime calcium and phosphate ingredients consecutively. Interaction of 
these ingredients can cause a precipitate in the finished solution. 

If the configuration includes a lipid, you should prime the Universal Ingredient 
(UI) immediately after priming the lipid. 

Always follow the configuration setup that Baxa Corporation recommends. 

Tip! Baxa Corporation recommends physically rotating each source container so that its 
product label faces you, for easy verification. 

3. Touch an ingredient button. 
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The ingredient detail window appears. 

 

Ingredient detail window before priming 

4. At the ingredient detail window, review the information. 
a. Check that the product information in the title bar of the window is correct. 
b. Check that the Port Number is correct. 
c. Check that the Ingredient description matches the source container to be used.  
d. Check that the Remainder (mL) matches the current volume of the source 

container to be used.  
e. Check that the Spike Type (inlet type) is correct. 

5. On the valve set, locate the port for this ingredient. 
6. With your hand, hold the inlet that is attached to the port, and follow the inlet up to the 

source container. 
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7. While continuing to hold the inlet near the source container:  
a. Check that the number on the inlet label matches the port number. 
b. Check that the product attached to the inlet matches the information on the 

screen. 
c. At the ingredient detail window, touch Prime. 
d. Check that a calibration bag is attached. 
e. At the Priming pump message, touch OK.  

 

Message 

f. Watch for fluid moving through the source-container end of the inlet that is in 
your hand. 

When an ingredient is being primed, its button becomes yellow. The screen 
displays an animation of the process.  

 

PRIME AND VERIFY screen, priming in progress 
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WARNING 

The ingredient must be attached to the correct port. Patient harm can occur if 
the location of an ingredient is incorrect. Always watch for the fluid to flow 
through the source-container end of the inlet. 

8. If the fluid: 

 Does flow through the inlet that is in your hand, continue with the next step 

 Does not flow through the inlet that is in your hand, resolve any problems, check 
that the inlet is attached to the correct port and prime it again 

After the inlet has been primed, the ingredient detail window includes a Verify button, 
and the Prime button becomes a Re-Prime button. 

 

Ingredient detail window after priming 

NOTE: The first prime uses the standard priming volume. Any subsequent primes use 
the minimum priming volume. 

9. Check the inlet to be sure that it primed correctly, leaving no air in the inlet tube. If 
necessary, touch Re-Prime. 

10. When priming is finished: 
a. Release the tube from your hand. 
b. Touch Verify to confirm that the ingredient’s inlet is attached to the correct port.  
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The connecting lines between the ingredient button and the port include horizontal 
marks, indicating that the ingredient has been primed. On the ingredient button, the 
red X becomes a green check mark, indicating that the ingredient has been verified. 

 

PRIME AND VERIFY screen, one inlet primed and verified 
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11. Repeat steps 3–10 for all the attached ingredients. If the calibration bag becomes full, 
remove it and attach an empty calibration bag. Refer to Attaching and Removing the 
Calibration Bag on Page 43. 

12. When you are finished, touch Close. 

 

PRIME AND VERIFY screen, all inlets primed and verified 

The software prompts you to flush with the Universal Ingredient (UI) to flush all 
ingredients out of the common fluid pathway and into the calibration bag. 

13. At the Fluid path will be flushed with UI message, touch OK. 

 

Message 
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The compounder flushes the common fluid pathway with the Universal Ingredient (UI), 
and tests for correct function of the occlusion detector. If the test fails, you cannot 
continue compounding a solution. Refer to Issues with the Occlusion Detector / “Flow 
Sensor” on Page 192. 

14. At the UI flush complete message, touch OK. 

 

Message 

If a cosigner was logged in, the software automatically logs out the cosigner and logs in 
the original user. 

If you started this procedure from the Setup Wizard screen, a check mark now appears 
next to Prime and Verify at the Setup Wizard screen. 
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CALIBRATING THE COMPOUNDER 

This procedure calibrates the compounder’s pump to ensure that it delivers the intended 
volume of each ingredient. 

1. At the Setup Wizard screen, touch Calibrate Compounder. 

 

Setup Wizard screen, calibrating the compounder 

NOTE: You can calibrate the compounder at any time by touching Compound > 
Calibrate Pump at the menu screen. 

 

WARNING 

To avoid using the wrong bag on a patient, a calibration bag should be used 
during all priming/verifying and Universal Ingredient (UI) flushes. 

2. If a calibration bag is not already attached, attach it. Refer to Attaching and Removing 
the Calibration Bag on Page 43. 

3. At the Calibrating pump message, touch OK. 

 

Message 
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4. If the Bag currently on the load cell does not appear to be empty message appears, 
visually check the contents of the bag. 

 If the bag is empty, refer to Page 191. 

 If the bag contains fluid, continue with the next step. 

5. Check whether the bag has space for an additional 200 mL of fluid. 

 If the bag does not have space: 

a. Touch No.  
b. At the Operation Cancelled message, touch OK. 
c. Remove the calibration bag and attach an empty calibration bag. Refer to 

Attaching and Removing the Calibration Bag on Page 43. 
d. Return to Step 1. 

 If the bag has space, touch Yes. 

IMPORTANT! Never touch Yes when compounding a solution into a patient bag. It is 
acceptable to calibrate the pump when the calibration bag contains fluid. However, 
the calibration procedure is the only time you should touch Yes at this message.  

 

Message 
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6.  At the Select Bag Type window: 
a. Select the type of bag you are using.  
b. Touch OK. 

 

Select Bag Type window,  
sample North American version 



Setting Up the Compounder 

Operator Manual for the Baxa EXACTAMIX 2400 Compounder 
Page 70 5300-0769 Rev. P 

 

WARNING 

If any items except the calibration bag touch the load cell during the 
calibration, the calibration will not be accurate 

7. Make sure that there is nothing except the calibration bag touching any part of the load 
cell (for example, there are no cables touching the base). 

The compounder pumps 100 mL of water, checks the weight, makes any necessary 
adjustments to the movement of the pump rotor, pumps 100 mL again and checks the 
weight again. If the Universal Ingredient for the configuration is something other than 
water, the compounder automatically flushes the common fluid pathway with the 
identified Universal Ingredient. 

This message appears and disappears: 

 

Message 

8. At the Pump calibration completed successfully message, touch OK.  

 

Message 

NOTE: If calibration fails, refer to Page 189. 

If you started this procedure from the Setup Wizard screen, a check mark now appears 
next to Calibrate Compounder at the Setup Wizard screen. 

9. Remove the calibration bag. Refer to Attaching and Removing the Calibration Bag on 
Page 43. 
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VIEWING THE AUTHORIZATION REPORT 

When the setup steps are finished, the Authorization Report button becomes active at the 
Setup Wizard screen. 

At the Setup Wizard screen, touch Authorization Report. 

 

Setup Wizard screen, viewing the Authorization Report 

NOTE: You can view the Authorization Report at any time by touching Reports > Authorization 
Report at the menu screen.  

For more information, refer to Authorization Report on Page 159. 

To exit the Setup Wizard screen, touch Exit. 
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USING THE COMPOUNDER 

ATTACHING THE PATIENT BAG 

Always use aseptic technique when attaching the bag. 

Tip! Baxa Corporation recommends attaching a barcode label to the patient bag before 
attaching the bag to the outlet tube. 

1. Connect a sterile patient bag to the outlet tube. 

Tip! Baxa Corporation recommends connecting the bag to the outlet tube before 
attaching it to the load cell, to prevent twisting or straining the tube. 

 

Attaching the patient bag to the outlet tube 

2. Attach the bag to the load cell. Place the holes in the corners of the bag over the guide 
pins on the load cell. 

3. Route the bag’s fill port through the load cell’s fill port holder. 
4. Make sure the outlet tube is curved, not twisted or kinked. 

 

Attaching the patient bag to the load cell 
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LOADING THE FORMULA 

There are several methods for loading a formula onto the compounder. They are: 

 Automatically loading a formula by scanning a barcode to retrieve the .PAT file 
(recommended) 

 Manually entering a formula through direct entry 

 Manually selecting a saved formula 

Tip! Baxa Corporation strongly recommends loading a formula by scanning a barcode, and using 
the manual entry or selection methods only when the barcode method fails. If the network 
connection to the order-entry computer fails, you can still load a formula by scanning a 
barcode. For instructions, refer to Loading a Formula by Connecting a USB Drive on Page 196. 

NOTE: If you choose to require barcode scanning for loading formulas, refer to Bar Code Reader 
on Page 118. 

Loading a Formula by Scanning a Barcode 

Tip! Baxa Corporation strongly recommends loading a formula by scanning a barcode. 

IMPORTANT! This method requires: 

 Order-entry software on a separate computer. This software must be able to produce 
both a .PAT file and a corresponding label with a barcode. Both the .PAT file and 
barcode must be compatible with the compounder. Baxa ABACUS Software meets these 
requirements. For more information, contact Baxa Corporation Technical Support. Refer 
to Getting Help on Page 17. 

 Network connection between the order-entry computer and the compounder 

 Barcode reader at the compounder 

In the order-entry software, the pharmacist creates an order, which creates a .PAT file that 
contains the patient information and the formula. A corresponding label with a barcode also 
prints at the same time.  

At the compounder: 

1. Navigate to the pump screen. 

 

WARNING 

Always attach the patient bag to the load cell before scanning the barcode on 
the label of the bag. If you scan the barcode label on one patient bag, become 
distracted and then attach a different patient bag to the load cell, patient harm 
may result. 

2. Check that the patient bag is attached. 
3. Scan the barcode on the label of the patient bag. 

The compounder retrieves the order through the network and populates the pump 
screen with the formula name, formula serial number, volume of each ingredient to be 
pumped and total volume to be pumped. 

4. Continue with Fulfilling the Order (Basic Process) on Page 81. 
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Entering a Formula Through Direct Entry 

Some facilities may use this method if the order-entry software is temporarily unavailable. With 
this method, you must manually enter the volume of each ingredient to create a new formula. 

This process creates a formula with a unique serial number, but it does not create a .PAT file or 
a corresponding label with a barcode. 

 

WARNING 

Formulas entered directly into the compounder should be checked by a pharmacist. 
The compounder does not verify the formulas. 

IMPORTANT! This function requires Formula Entry permissions. For more information about 
user groups and permissions, refer to Setting Up the Users on Page 121. 

1. At the menu screen, touch Tools > Direct Entry. 

 

Menu screen, Tools menu 

NOTE: To stop using direct entry, you can touch Tools > Cancel Direct Entry at the 
menu screen. 



Using the Compounder 

Operator Manual for the Baxa EXACTAMIX 2400 Compounder 
5300-0769 Rev. P Page 75 

The pump screen appears. The text DIRECT ENTRY appears on the left side. 

 

Pump screen during direct entry 

2. Obtain the formula from the pharmacist. Refer to your facility’s protocol. 
3. Touch the ingredient button for the first ingredient in the formula. 
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The ingredient detail window appears. 

 

Ingredient detail window during direct entry 

4. At the ingredient detail window: 
a. Check that the Ingredient shown matches the ingredient ordered. Check its 

description and concentration. 
b. Enter the Ordered Volume of the ingredient to be delivered. 
c. Touch Save, or touch Next to view the next ingredient detail window. 

The Run button becomes available on the pump screen. 

5. Repeat steps 3–4 for each ingredient in the formula. 
6. If you want to: 

 Use the formula now, continue with Saving and Using a Direct-Entry Formula on 
Page 77 

 Save the formula for using later, continue with Saving a Direct-Entry Formula to Use 
Later on Page 78 
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Saving and Using a Direct-Entry Formula 

NOTE: For information about automatic unloading of formulas, refer to Understanding 
Automatic Unloading of Formulas on Page 81. 

1. At the pump screen, touch Run. 
2. At the Formula Information window: 

a. Enter a Formula Name. 
b. If desired, enter a new Serial Number. 

Tip! The serial number is based on the date and time the formula was directly 
entered. Baxa Corporation recommends not changing the serial number.  

c. Touch OK. 

 

Formula Information window 

3. Continue with Compounding the Solution on Page 82. 

NOTE: You do not need to touch Run again. 
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Saving a Direct-Entry Formula to Use Later 

1. At the pump screen, touch Menu. 
2. At the Information message, touch OK. 

 

Message 
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3. At the Formula Information window: 
a. Enter a Formula Name. 
b. If desired, enter a new Serial Number. 

Tip! The serial number is based on the date and time the formula was directly 
entered. Baxa Corporation recommends not changing the serial number.  

c. Touch OK. 

 

Formula Information window 

4. When you want to compound the solution, continue with Selecting a Saved Formula on 
Page 79. 

Selecting a Saved Formula 

Some facilities may use this method to retrieve a formula, which has been created in the order-
entry software, without scanning a barcode. 

IMPORTANT! This method requires: 

 Order-entry software on a separate computer. This software must be able to produce a 
.PAT file that is compatible with the compounder. ABACUS Software meets this 
requirement. For more information, contact Baxa Corporation Technical Support. Refer 
to Getting Help on Page 17. 

 Network connection between the order-entry computer and the compounder 

 Ability for formulas to be loaded without scanning barcodes. For more information, 
refer to Bar Code Reader on Page 118. 
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1. At the menu screen, touch Compound > Select Formula. 

The Select Formula window appears. 

 

Select Formula window 

2. At the Select Formula window, touch one of these filter options:  

 Show All Formulas to view all the formulas that are stored 

 Show Unpumped Formulas to view all the formulas that have not been used for 
compounding 

 Show Pumped Formulas to view all the formulas that have been used for 
compounding 

Tip! Baxa Corporation recommends selecting only Show Unpumped Formulas. 

NOTE: You can touch Formula Name to sort by name or touch Serial Number to sort by 
number. Formulas are stored for a specified time period. To set up the storage of 
formulas, refer to Storage on Page 114. 

3. Select a formula.  
4. Touch OK. 

The formula is loaded and appears on the pump screen.  

5. Continue with Fulfilling the Order (Basic Process) on Page 81. 
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FULFILLING THE ORDER (BASIC PROCESS) 

Understanding Automatic Unloading of Formulas 

As a safety precaution, the software automatically unloads the formula in these two main 
situations: 

 The software usually unloads the formula if you leave the pump screen after loading the 
formula and before starting the compounding process. 

The message below, or one similar to it, appears and then automatically disappears. 

NOTE: The only exception is that the software does not unload the formula when you 
perform an auto-addition. 

 

Message 

 The software usually unloads the formula when compounding is finished, regardless of 
the outcome. 

No message appears; however, you cannot use the formula for compounding again.  

NOTE: The only exception is that the software does not unload the formula when either 
of these conditions occur: 

 The solution limit is more than 1 and has not yet been met, or the solution limit 
is disabled. For more information, refer to Solution Limit on Page 119. 

 Barcode scanning is not required to load a formula, but the formula was loaded 
through this method. For more information, refer to Bar Code Reader on 
Page 118. 
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Compounding the Solution 

IMPORTANT! This function requires Compounder permissions. For more information about 
user groups and permissions, refer to Setting Up the Users on Page 121. 

1. At the pump screen, touch Run. 

 

Pump screen, ready to start compounding the solution 
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2. If the Bag currently on the load cell does not appear to be empty message appears, 
visually check the contents of the bag. 

 If the bag is empty, refer to The bag currently on the load cell does not appear to be 
empty on Page 191. 

 If the bag contains fluid: 

a. Touch No. 
b. At the Operation Cancelled message, touch OK. 
c. If the attached bag is a patient bag, write a large “X” on the label. 
d. Remove the bag from the load cell. Depending on the type of the attached bag, 

refer to: 

 Removing the Patient Bag on Page 86 

 Attaching and Removing the Calibration Bag on Page 43 

NOTE: The calibration bag may have been left on the load cell. 

e. Discard the bag. 
f. Attach an empty patient bag. Refer to Attaching the Patient Bag on Page 72. 
g. Return to Step 1. 

 

Message 

 

WARNING 

If you touch Yes, the compounder will reset the measured weight to zero, 
despite the fact that the bag contains fluid.  

The finished solution may contain an unintended volume or ingredient, even if 
the final measured weight is within the acceptable range. This unintended 
volume or ingredient may result in patient harm. 

The Details section of the MixCheck Report will indicate that you continued 
compounding despite the warning that the bag did not appear to be empty. 

This bag should be discarded. 
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3. At the Select Bag Type window: 
a. Select the size of the bag you attached. 
b. Touch OK. 

 

Select Bag Type window 
(may vary by region) 
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At the pump screen, the Run button becomes a Pause button. The compounder pumps 
each ingredient, one at a time, into the patient bag in the specified sequence and 
volume. When an ingredient is being pumped, its button becomes yellow. 

 

Pump screen, compounding the solution 

NOTE: For information about messages that might appear just before or during the 
compounding process, refer to Fulfilling the Order (Additional Steps) on Page 87. If you 
need to stop compounding temporarily, you can perform either of the following actions. 

 Touch Pause, then touch Resume to continue compounding. 

 Open the pump door, then close the pump door and touch Resume to continue 
compounding.  
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When compounding is finished, a message displays this information about the patient 
bag:  

 Expected weight 

 Actual weight 

 Difference 

 Statement about whether or not the difference is acceptable 

NOTE: If the difference is not acceptable, refer to Issues with the Weight and Load Cell 
on Page 189. The acceptable difference is typically set to ± 5%. To change this setting, 
refer to Acceptable Weight Variances (%) on Page 116. 

4. At the message with information about the patient bag, touch OK. 

 

Message 

Removing the Patient Bag 

Always use aseptic technique when removing the bag. 

1. Remove the bag’s fill port from the load cell’s fill port holder. 
2. Remove the bag from the load cell. 
3. Disconnect the outlet tube from the bag, to allow fluid in the bag’s fill port to drain into 

the bag. 
4. Clamp the bag’s fill port. 
5. Connect the end of the outlet tube to the tube holder on the vial rack. 
6. Cap the bag’s fill port. 

Completing the Order 

 

WARNING 

It is important to inspect the finished solution to make sure that it complies with 
standards. 

1. Visually inspect the finished solution in the patient bag for precipitates and particulates 
according to your facility’s protocol. 

2. View and approve the MixCheck Report according to your facility’s protocol. For 
instructions, refer to MixCheck Report on Page 154. 

3. If necessary, perform any manual additions. Refer to Performing a Manual Addition on 
Page 90. 
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FULFILLING THE ORDER (ADDITIONAL STEPS) 

To complete some orders, you may need to perform additional steps along with the basic steps 
already explained. Interruptions to the compounding process may occur. These additions and 
interruptions are part of normal operation. 

Performing an Auto-Addition 

An auto-addition allows you to add an ingredient to the existing configuration temporarily, to 
fulfill the current order, instead of selecting a new configuration (which would require you to 
prime and verify all the inlets and ingredients). 

If the loaded formula includes an ingredient that is not attached to the compounder, but is 
identified as an allowable auto-addition in the formulary and the current configuration, a 
Confirm message appears.  

1. At the Confirm message, touch OK.  

 

Message 
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WARNING 

The ingredient should be attached to a specific port, with incompatible 
ingredients adequately separated to avoid precipitation. If a port reference is 
not available, contact Baxa Corporation Technical Support. Refer to Getting 
Help on Page 17. 

2. At the Select port window: 
a. Select the port to which you will attach the ingredient. 
b. Touch OK. 

 

Select port window 
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3. At the Specify New Container window: 
a. Select the Product Name. 
b. Touch OK. 

 

Specify New Container window 
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4. Attach the new ingredient and inlet. Refer to Attaching the New Ingredients and Inlets 
on Page 45. 

5. If you have already attached the patient bag, remove it. Refer to Removing the Patient 
Bag on Page 86. 

6. Attach a calibration bag. Refer to Attaching and Removing the Calibration Bag on 
Page 43. 

7. Prime and verify the new inlet and ingredient. Refer to Priming and Verifying on 
Page 55. 

NOTE: After priming and verifying, the compounder flushes the common fluid pathway 
with the Universal Ingredient (UI). 

8. Remove the calibration bag. Refer to Attaching and Removing the Calibration Bag on 
Page 43. 

9. Attach the patient bag. Refer to Attaching the Patient Bag on Page 72. 

NOTE: You can reattach the original patient bag. 

10. Continue with compounding the solution. Refer to Compounding the Solution on 
Page 82. 

NOTE: The formula is not unloaded from the pump screen. 

Performing a Manual Addition 

A manual addition allows you to add an ingredient to the finished solution manually. This type 
of addition may be necessary when the loaded formula includes an ingredient that meets at 
least one of these conditions: 

 It is not in the configuration.  

 Its ordered volume is less than the 0.2 mL minimum required for use on the 
compounder. 

 Its Drug ID does not match any Drug ID in the compounder’s formulary. Refer to A Drug 
ID in the formula does not match any Drug ID in the formulary on Page 185. 
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If a formula loaded by scanning a barcode includes an ingredient that must be added manually: 

 A Manual Add button appears on the left side of the pump screen. You can touch this 
button to view information about the ingredients that must be added manually. 

 

Pump screen with manual addition 

 The MixCheck Report includes a list of any ingredients that must be added manually. 
For more information, refer to MixCheck Report on Page 154. 

To add ingredients manually, follow your facility’s protocol. 

NOTE: To set the maximum volume allowed for a manual addition, refer to Manual Add on 
Page 116. 
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Replacing a Source Container 

If you are fulfilling a series of orders, an ingredient may become depleted and need to be 
replaced. When a formula is loaded and requires more ingredient volume than what remains in 
the source container, the vertical bar on the ingredient button flashes. If you start 
compounding, the Swap Container window appears when the ingredient’s remaining volume is 
depleted. 

 

Swap Container window 

1. Check that the source container is appropriately depleted.  

 

WARNING 

If there is a large amount of fluid remaining in the source container, or if the 
container has emptied completely and forced air into the inlet, there may be a 
delivery problem. For assistance with troubleshooting, contact Baxa 
Corporation Technical Support. Refer to Getting Help on Page 17. 

2. At the Swap Container window, touch one of these options:  

 Touch Swap is complete to replace the empty container with an exact match (same 
ingredient, container size, container type and manufacturer). Use aseptic technique 
to replace the source container.  

  Touch Use a different container to replace the empty container with the same 
ingredient from a different container size, container type or manufacturer. Use 
aseptic technique to replace the source container. 

NOTE: Using a different container may require you to change and prime the inlet. 
Refer to Attaching the New Ingredients and Inlets on Page 45 and Priming and 
Verifying on Page 55. 



Using the Compounder 

Operator Manual for the Baxa EXACTAMIX 2400 Compounder 
5300-0769 Rev. P Page 93 

 Touch Stop filling and throw bag away to cancel the order. At the pump screen, 
touch Stop and follow the on-screen instructions. 

 Touch Use some overfill to use the overfill in the current container to complete the 
order. At the Overfill Volume window: 

a. Enter the Overfill volume to use.  

 

WARNING 

Adjusting the value incorrectly in the Overfill volume to use field can 
lead to bubbles, occlusions and under-delivery of an ingredient if its 
source container runs empty. 

b. Touch OK. 

 

Overfill Volume window 
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Handling an Air Bubble 

An air bubble can occur at any time, but it most frequently occurs after priming the inlet during 
setup or after replacing a source container. A bubble can be caused by an incorrectly spiked 
container, an empty container or incomplete priming. 

When the bubble detector finds a bubble in the outlet tube over the detector, the 
compounding process stops and an alarm beeps. A message also appears.  

1. At the Bubble was detected while pumping from port <port number> message, 
touch OK. 

 

Message 

 

WARNING 

A bubble in the common fluid pathway displaces the volume of one or more 
ordered ingredients, causing an under-delivery of these ingredients. 

2. Determine the impact of the bubble:  
a. Check the size of the bubble using the EM2400 Bubble Chart (5300-0868) to 

determine the volume of fluid displaced. 
b. If more than one bubble is present, evaluate each bubble and add the values 

together to determine the total volume of fluid displaced. 
c. Identify all the ingredients pumped prior to the alarm, the ingredient pumped 

during the alarm and the volume of each ingredient ordered. 

 

Using the EM2400 Bubble Chart 

Tip! Baxa Corporation recommends that a pharmacist evaluate the clinical significance 
of bubbles encountered during the compounding process. 
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3. Ask a pharmacist to determine if the displaced volume is clinically significant for any of 
the ingredients pumped. Assume that the total displaced volume applies to each 
ingredient ordered. 

4. If the clinical significance: 

 Is acceptable, touch Resume at the pump screen to continue compounding the 
solution, and do not continue with the steps below 

 Is not acceptable, or cannot be determined, continue with the next step to cancel 
the order 

Tip! Baxa Corporation recommends documenting all decisions according to your 
facility’s protocol. 

5. Immediately write a large “X” on the label of the patient bag.  
6. At the pump screen, touch Stop. 
7. At the Really abort the current solution? message, touch Yes.  

 

Message 

The software unloads the formula. 

8. At the Operation Cancelled message, touch OK. 

 

Message 
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9.  At the Fluid path will be flushed with UI message, touch OK. 

 

Message 

10. Check that the fluid moves correctly during the flush. 
11. At the UI flush complete message, touch OK. 

 

Message 

12. Remove the bag. Refer to Removing the Patient Bag on Page 86. 
13. Discard the bag. 

NOTE: To help reduce the occurrence of bubbles: 

 Use correct technique to spike the containers. Refer to the steps for spiking a container, 
starting on Page 49. 

 Re-prime any inlets that have visible bubbles. Refer to Priming the Inlets and Verifying 
the Setup on Page 59. 

 Increase the priming volume in the configuration. Refer to Adding or Editing a 
Configuration on Page 130. 

NOTE: To help avoid false bubble detections:  

 Clean the channel over the bubble detector. Refer to Cleaning the Compounder on 
Page 100. 

 Make sure that the outlet tube is in the correct position. It should be at the bottom of 
the channel over the bubble detector. Refer to Step 8a on Page 42. 
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Handling an Occlusion 

An occlusion can be caused by an empty syringe, stuck syringe plunger, kinked tube or other 
obstruction in the inlet. 

When the occlusion detector detects that a vacuum was drawn, indicating an occlusion 
somewhere between the source container and the detector, the compounding process stops 
and an alarm beeps. A message appears, and a red occlusion symbol also appears near the 
ingredient button. 

 

Occlusion symbol 

1. Immediately write a large “X” on the label of the patient bag. 
2. At the Occlusion was detected while pumping from port <port number> message, 

touch OK. 

  

Message 

3. At the pump screen, touch Stop. 
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4. At the Really abort the current solution? message, touch Yes.  

 

Message 

The software unloads the formula. 

5. At the Operation Cancelled message, touch OK. 

 

Message 

6. Check that: 

 The outlet tube is straight and flat on the occlusion detector. 

 The occlusion detector is not damaged or dirty. 

 The inlets have no obstructions, kinks or tangles. If necessary, replace the inlets. 
Refer to Changing the Tube Set on Page 38. 

 The appropriate inlet is used with each source container. 

 Each syringe has fluid and its plunger is not stuck. 
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NOTE: If you cannot find the cause for the occlusion, contact Baxa Corporation Technical 
Support. Refer to Getting Help on Page 17. 

7. At the Fluid path will be flushed with UI message, touch OK. 

 

 Message  

8. Check that the fluid moves correctly during the flush. 
9. At the UI flush complete message, touch OK. 

 

Message 

10. Remove the bag. Refer to Removing the Patient Bag on Page 86. 
11. Discard the bag. 
 

Handling Other Interruptions and Errors 

For more information about handling interruptions and errors, refer to Troubleshooting on 
Page 183. 
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MAINTAINING THE COMPOUNDER 

To keep the compounder in the best possible condition, perform these routine maintenance 
tasks: 

 Calibrate the load cell 

 Change the tube set 

 Clean the compounder 

 Calibrate the compounder  

 Shut down and start up the compounder, to back up and compact the database 
automatically 

CALIBRATING THE LOAD CELL 

This procedure is usually performed as part of the daily setup. 

For instructions, refer to Calibrating the Load Cell on Page 33. 

CHANGING THE TUBE SET 

This procedure is usually performed as part of the daily setup. 

For instructions, refer to Changing the Tube Set on Page 38. 

CLEANING THE COMPOUNDER 

This procedure is usually performed as part of the daily setup before installing the new tube 
set, or whenever there is a spill. You can clean the compounder more often than once a day if 
indicated by your facility’s protocol. 

Use only these approved materials: 

 Non-abrasive cloth  

 Soap and water 

 70% isopropyl alcohol or another self-drying disinfectant 

 

CAUTION 

Cleaning is required to ensure that the compounder operates as intended. Failure to 
clean the compounder can impair its operation. 

Do not immerse the compounder in liquid or use sodium hypochlorite solutions (for 
example, Clorox®). 

Do not disassemble the compounder beyond the steps described in this procedure. 
Disassembling the compounder may damage the connections, increase the risk of 
dropped parts, and void the manufacturer’s warranty. 

The compounder must have its power turned off before cleaning. 
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1. Shut down and turn off the compounder. Refer to Rebooting and Shutting Down on 
Page 29. 

2. If the tube set is installed, remove and discard it. Refer to Removing the Expired Tube 
Set and Expired Ingredients on Page 40. 

3. Open the pump door.  
4. Remove and retain the thumbscrew and washer used to attach the rotor.  

 

Removing the thumbscrew 

5. Remove the pump rotor from the spindle.  

 

Removing the pump rotor 

6. Using the approved materials, clean the: 
a. Pump rotor, making sure that the rollers spin freely 
b. Pump rotor area 
c. Channels near the pump rotor area 

7. Install the: 
a. Pump rotor, aligning the notch on the bottom of the rotor with the pin on the 

spindle 
b. Washer and thumbscrew 

8. Close the pump door. 
9. Using the approved materials, clean the: 

a. Valve actuators, and inspect them for damage 
b. Surface of the main module 
c. Poles and holders on the vial rack 
d. Display 
e. Barcode reader 
f. Load cell 
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WARNING 

With the vial rack attached, the compounder weighs 88.5 lb (40.14 kg). 
If necessary to prevent injury, use a second person to help move the 
compounder. 

10. Tip the main module back and extend the support legs.  

 

Extending the support legs 

NOTE: In a small hood, there may not be enough space behind the main module to tip it 
back. To make more space, you can move the compounder forward by lifting the front 
of the base plate slightly and sliding it toward you. It is easier to slide the base plate on 
its back feet (which are plastic) than on its front feet (which are rubber). If necessary, 
you can also pull up and remove the vial rack. 

11. Clean the top of the base plate.  
12. Retract the support legs so that the main module rests fully on the base plate.  
13. If you want to clean the hood under the base plate: 

a. Move the compounder by lifting the front of the base plate slightly and sliding it 
to the desired location. 

b. Clean the hood. 

CALIBRATING THE COMPOUNDER  

This procedure is usually performed as part of the daily setup. 

For instructions, refer to Calibrating the Compounder on Page 67. 

Support legs 



Maintaining the Compounder 

Operator Manual for the Baxa EXACTAMIX 2400 Compounder 
5300-0769 Rev. P Page 103 

SHUTTING DOWN AND STARTING UP THE COMPOUNDER 

Tip! Baxa Corporation recommends fully shutting down and starting up the compounder once a 
day, to allow the software to perform routine database maintenance. 

For instructions, refer to Starting Up, Logging In and Out, and Shutting Down on Page 26.  

The compounder’s database accumulates data related to solutions, formulas and logs. For 
example, the software records important device activity in a Blackbox log, which Baxa 
Corporation can access through the Blackbox Report when needed. The compounder stores this 
data for a specified time period. To set up the storage options, refer to Storage on Page 114. 

When you shut down the compounder, it backs up the database automatically. If required 
during troubleshooting, you can use the backup data to restore the software settings to an 
earlier state.  

When you start up the compounder, it compacts the database automatically. Compacting the 
database reduces its space on the hard drive and keeps the compounder operating efficiently. 
To see the compaction settings, refer to Database Compaction on Page 115. 

IMPORTANT! Failing to shut down the compounder may cause the database to grow to a size 
that decreases performance, and compacting the database manually may be required to 
resolve this issue. For instructions, refer to Compacting the Database Manually on Page 106. 

BACKING UP AND COMPACTING THE DATABASE MANUALLY 

If you fully shut down and start up the compounder once a day, there is no need to back up or 
compact the database manually. The compounder performs these actions automatically.  

However, if more than seven days have passed since the last backup occurred, the software 
notifies you when you next log into the compounder. In this situation, perform a manual 
backup and compaction. For instructions, refer to the following pages. 

Tip! Baxa Corporation also recommends performing a manual backup after changing the system 
settings.  
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Backing Up the Entire Database Manually 

This procedure backs up the entire database, including the Blackbox log. 

1. At the menu screen, touch Tools > Database > Backup All. 
2. At the Backup Database Location window: 

a. If you want to change the location of the backup, touch the button to the right of 
the Database File Name field and navigate to the new location (not 
recommended). 

b. If you want to: 

 Keep the previous backup files of the same name, clear the Overwrite 
Existing File? check box 

 Replace all the previous backup files of the same name to save space, select 
the Overwrite Existing File? check box. If the displayed file name is different 
from the one you want to replace, touch the button to the right of the 
Database File Name field, then navigate to and select the existing file. 

c. Touch OK.  

 

Backup Database Location window 

3. At the Backup succeeded message, touch OK. 

 

Message 
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Backing Up the Blackbox Log Manually 

This procedure backs up only the Blackbox log. 

1. At the menu screen, touch Tools > Database > Backup Blackbox. 
2. At the Backup Blackbox Location window: 

a. If you want to change the location of the backup, touch the button to the right of 
the Blackbox File Name field and navigate to the new location (not 
recommended). 

b. If you want to: 

 Keep the previous backup files of the same name, clear the Overwrite 
Existing File? check box 

 Replace all the previous backup files of the same name to save space, select 
the Overwrite Existing File? check box. If the displayed file name is different 
from the one you want to replace, touch the button to the right of the 
Blackbox File Name field, then navigate to and select the existing file. 

c. Touch OK.  

 

Backup Blackbox Location window 

3. At the Backup succeeded message, touch OK. 

 

Message 
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Compacting the Database Manually 

1. At the menu screen, touch Tools > Database > Maintenance. 
2. At the Do Database Maintenance? message, touch OK. 

 

Message 
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PERFORMING ADVANCED TASKS 

For assistance with any of these tasks, contact Baxa Corporation Technical Support. Refer to 
Getting Help on Page 17. 

CHANGING THE UNIVERSAL INGREDIENT 

IMPORTANT! This function requires Change Universal Ingredient permissions. For more 
information about user groups and permissions, refer to Setting Up the Users on Page 121.  

To change the Universal Ingredient when you are not in the process of compounding a solution, 
do the following procedure. To change the volume used for flushing during a Universal 
Ingredient change, refer to Flush Between UI Changes on Page 116. 

1. At the menu screen, touch Tools > Change Universal Ingredient. 

 

Menu screen, Tools menu 
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A Change Universal window appears. It lists any ingredients that are specified as a UI in 
the Formulary Editor (refer to Adding or Editing an Ingredient on Page 139), included at 
a UI port in the configuration (refer to Adding or Editing a Configuration on Page 130) 
and have an ordered volume that is sufficient for a UI. 

2. At the Change Universal window: 
a. Select the Universal Ingredient you want to use. 
b. Touch OK. 

 

Change Universal window 

The compounder requires a flush of the new Universal Ingredient to clear the old 
Universal Ingredient from the common fluid pathway. 

3. Attach a calibration bag. Refer to Attaching and Removing the Calibration Bag on 
Page 43. 

4. At the Flushing with Universal Ingredient message, touch OK. 

 

Message 

The pump screen shows an animation of the flush. 
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5. When the Completed flushing message appears, remove the calibration bag. Refer to 
Attaching and Removing the Calibration Bag on Page 43. 

6. When you will continue with compounding a solution, attach a patient bag. Refer to 
Attaching the Patient Bag on Page 72. 

7. At the Completed flushing message, touch OK.  

 

Message 

CHANGING THE INGREDIENT REMAINDERS 

For each ingredient, the compounder tracks the volume that is used and the volume that 
remains in the source container (the remainder). If necessary, you can manually change each 
remainder shown in the software. 

 

WARNING 

The remainder value in the software must accurately represent the actual volume 
remaining in the source container. Change a remainder value only when you know the 
precise amount remaining in the source container. Incorrect remainder values can 
lead to bubbles, occlusions and under-delivery of an ingredient if its source container 
runs empty. 

IMPORTANT! This function requires Compounder permissions. For more information about 
user groups and permissions, refer to Setting Up the Users on Page 121. 
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1. At the menu screen, touch Compound > Edit Source Remainders.  
2. At the Edit Source Remainders window: 

a. For the desired ingredient, change the Remainder to correspond to the volume 
remaining in the container. 

NOTE: You can touch Reset to change the remainder to its default value, or 
touch Reset All to change all the remainders to their default values at the 
same time.  

Tip! Baxa Corporation does not recommend using Reset All unless the entire list 
of ingredients has been changed. 

b. Touch OK.  

 

Edit Source Remainders window 

 



Setting Up the Options 

Operator Manual for the Baxa EXACTAMIX 2400 Compounder 
5300-0769 Rev. P Page 111 

SETTING UP THE OPTIONS 

IMPORTANT! These functions require Administration permissions. For more information about 
user groups and permissions, refer to Setting Up the Users on Page 121. 

NOTE: At any tab of the Options window: 

 Touching OK saves the changes made on all the tabs and requires you to reboot the 
compounder. 

 Touching Cancel closes the window without saving any changes. 

SETTING UP THE SYSTEM OPTIONS 

Use the System tab to set up the general system options. 

To access the system options, touch Tools > Options at the menu screen. 

At the Options window, the System tab is selected. 

 

Options window, System tab 
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MixCheck Report 

The MixCheck Report is available after compounding is finished. For more information about 
the contents of this report, refer to MixCheck Report on Page 154. 

If desired, select one or more of these check boxes: 

 Select Use Online MixCheck Authorization if you want to require a qualified user to log 
in with a password to approve each MixCheck Report on the screen. 

 Select Enable Auto-Display if you want the MixCheck Report to appear automatically on 
the display after compounding is finished. 

 Select Enable Auto-Print if you want the MixCheck Report to print automatically after 
compounding is finished. 

Tip! Baxa Corporation recommends selecting Enable Auto-Print. 

Authorization Report  

The Authorization Report is available after the Setup Wizard is finished, or from the Reports 
menu. For details about the contents of this report, refer to Authorization Report on Page 159. 

Select Auto Fill if you want to make the Assembled and Verified columns of the report 
populate automatically with the name of the person who logged in to perform the task. 

Load Cell  

IMPORTANT! Baxa Corporation does not recommend changing these settings. Before changing 
any of them, contact Baxa Corporation Technical Support. Refer to Getting Help on Page 17. 

Select Use load cell if you want to use the compounder’s scale. This box should always be 
selected, except if the load cell is not functional and an external scale is available. If you select 
this check box, the following options become available. 

Select Check for empty bag if you want to make the load cell check for the absence of a bag or 
the presence of a non-empty bag. If you select this check box, numbers appear in both of these 
fields: 

 For Min Empty Weight, enter the minimum expected weight of an empty bag. If the 
load cell measures a weight less than this number at the start of compounding, a 
warning message indicates that a bag may not be attached to the load cell.  

IMPORTANT! Baxa Corporation does not recommend changing this setting without first 
contacting Baxa Corporation Technical Support. Refer to Getting Help on Page 17. 

 For Max Empty Weight, enter the maximum expected weight of an empty bag. If the 
load cell measures a weight greater than this number at the start of compounding, a 
warning message indicates that the bag on the load cell may not be empty. 

IMPORTANT! Baxa Corporation does not recommend changing this setting without first 
contacting Baxa Corporation Technical Support. Refer to Getting Help on Page 17. 

Tip! Baxa Corporation recommends selecting Check for empty bag. 
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Track Product Expiration Date and Lot Number  

Select Enabled if you want to track the expiration date and lot number for every source 
container that is attached to the compounder. If you select this check box, these options 
become available: 

 Select Use Previous Values, No Confirm if you want the compounder to use the 
previous date and lot number without requiring confirmation. 

 Select Use Previous Values, Confirm if you want the compounder to use the previous 
date and lot number but require confirmation. 

 Select Require Entry if you want the user to enter values each time a new container is 
attached. 

Logging  

IMPORTANT! Baxa Corporation does not recommend changing these settings. Before changing 
any of these settings, contact Baxa Corporation Technical Support. Refer to Getting Help on 
Page 17. 

Regardless of the Logging settings, the compounder stores records in a Blackbox log. For 
information about viewing the contents of this log, refer to Blackbox Report on Page 172. 

In most cases, it is not necessary to change the Logging settings. Selecting any of these check 
boxes may cause the log to grow to a size that slows the performance of the software. 

Demo  

Demo mode simulates the compounder’s operation. It can be used during training. 

Select Demo mode if you want to enable demo mode. If you select this check box, these 
options become available: 

 Select Warp factor if you want to make the simulation perform compounding 
operations faster than normal. 

 For Pump Skew, enter a number. Entering a number other than 1.05 forces the 
simulation to pump inaccurately, for training purposes. 

NOTE: Operating in demo mode affects the ingredient remainders. Do not use demo mode with 
ingredients attached. 



Setting Up the Options 

Operator Manual for the Baxa EXACTAMIX 2400 Compounder 
Page 114 5300-0769 Rev. P 

Storage  

The storage fields set the number of days that the database stores solution, formula and log 
(Blackbox) information. Information older than the specified storage period is purged when the 
software starts up. 

You can increase or decrease these settings: 

 For Solution Storage (Days), enter the number of days that used formulas are available 
in the database. 

 For Formula Storage (Days), enter the number of days that unused formulas are 
available in the database. 

 For Log Storage (Days), enter the number of days that Blackbox information is available 
in the database. The minimum is 45 days. 

Tip! Baxa Corporation recommends entering at least 45 days for each of these fields. 

MixCheck Data Export  

Select Enable if you want the compounder to export data directly to the Baxa DoseEdge 
System. 

For this feature, the DoseEdge System must be specified as the printer. For assistance with 
setting up printers, contact Baxa Corporation Technical Support. Refer to Getting Help on 
Page 17. 

Tube Set Expiration 

 

WARNING 

Changes to these settings can affect patient safety. Before changing any of these 
settings, contact Baxa Corporation Technical Support. Refer to Getting Help on 
Page 17. 

Select Enable if you want the compounder to display a message when the tube set has been 
used longer than recommended.  

For Max Hours to Use Tube Set, enter the maximum number of hours that the tube set should 
be used. 

Tip! Baxa Corporation recommends entering 20 for the Max Hours to Use Tube Set, so that the 
tube set expires shortly before (instead of shortly after) the daily setup.  
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SETTING UP THE SYSTEM (CONTINUED) OPTIONS 

The System Cont. tab is a continuation of the System tab. 

To access the continued system options: 

1. At the menu screen, touch Tools > Options. 
2. At the Options window, touch the System Cont. tab.  

 

Options window, System Cont. tab 

Database Compaction  

IMPORTANT! Do not clear the Compact DB check box unless directed by Baxa Corporation 
Technical Support. 

When the Compact DB check box is selected, the compounder compacts the database at 
startup. 
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Acceptable Weight Variances (%)  

IMPORTANT! Changing the default settings of 5% for the Final Solution and 5% for the 
Individual Ingredient is not recommended. 

For Final Solution, enter the maximum acceptable difference between the expected and actual 
weight of the compounded solution. If any compounded solution has a weight outside this 
range, an alarm beeps and a message displays the results in red. The results also appear on the 
MixCheck Report. 

For Individual Ingredient, enter the maximum acceptable difference between the expected and 
actual weight of each delivered ingredient. If any delivered ingredient has a weight outside this 
range, a message appears. The compounder weighs only individual ingredient deliveries of 
100 mL or more. 

Manual Add  

For Max manual add volume, enter the maximum volume that can be used for a manual 
addition without a message appearing. If the volume of a formula ingredient exceeds this 
amount, a message appears, with options to add the ingredient manually or cancel 
compounding. 

Flush Between UI Changes  

For Volume (mL), enter the final flush volume used to clear the common fluid pathway after 
changing the Universal Ingredient (UI). 

NOTE: A Universal Ingredient flush contains three deliveries with standard volumes of 50, 50 
and 30 mL. Changing the Volume setting only changes the last of the three deliveries. 

Report Printer  

Select the printer to use for printing reports. 

MixCheck Data Export Printer  

Select the printer to use for sending MixCheck data to the DoseEdge System. 

MixCheck Signature Label  

Enter the text to include at the bottom of the MixCheck Report. 

Authorization Report Signature Label  

Enter the text to include about required signatures in the Authorization Report. 
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SETTING UP THE SECURITY OPTIONS 

Use the Security tab to set the security features according to your facility’s protocol. 

To access the security options: 

1. At the menu screen, touch Tools > Options. 
2. At the Options window, touch the Security tab.  

 

Options window, Security tab 

General  

Select Use Security if you want each user to sign in with a user ID and password.  

Select Remember last login if you want the login box to populate automatically with the user ID 
of the last user who logged in. Only the user ID populates; the user must enter a password each 
time.  

Auto-Logout  

Select Use Auto-Logout if you want the current user to be logged out automatically after a 
period of inactivity. 

For Minutes to Auto-Logout, enter the number of minutes after which the user is logged out. 

Tip! Baxa Corporation recommends entering 10 for the Minutes to Auto-Logout.  
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Password Expiration 

If your facility’s protocol requires that user passwords must be changed on a regular basis, 
select Use password expiration to place an expiration date on each password. 

For Days password valid, enter the number of days after which the password expires.   

Bar Code Reader 

 

WARNING 

It is important to use a barcode reader for scanning barcode labels on source 
containers and inlets during verification of the setup and for loading formulas. 

If you select Enable bar code reader, the barcode reader can be used for loading formulas and 
scanning barcode labels on source containers and inlets during verification of the setup. These 
additional options become available: 

 Select Use bar code verification if you want to require the use of a barcode reader for 
scanning barcode labels on source containers and inlets during verification of the setup.  

 Select Require bar code to initiate compounding if you want to require the use of a 
barcode reader for loading formulas. If this box is selected, the user cannot manually 
select a saved formula. 

If you do not select Enable bar code reader, the barcode reader cannot be used for any 
functions. 

Default User 

 

WARNING 

Using this feature can affect patient safety and is not recommended. 

If your facility does not require users to log in, select a Default User who is logged in 
automatically at startup. 

Cosignature 

Select Required for Configuration Verification if you want to require a second user to log in 
and verify the configuration. If this option is not selected, the same user can set up and verify 
the configuration.  

IMPORTANT!  Baxa Corporation strongly recommends requiring a second user to verify the 
daily setup of the compounder. 

Select Required for MixCheck Authorization if you want to require a second user to log in and 
verify the MixCheck Report on the screen after compounding.  
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Solution Limit 

Select Limit formula runs if you want to limit the number of times a specific formula can be 
used for compounding. 

For Max, enter the maximum of times an individual formula can be used. 

Tip! Baxa Corporation recommends entering 1 for the Max. 

SETTING UP THE DIRECTORIES OPTIONS 

Use the Directories tab to set the locations of formula files, reports and backups.  

To access the directories options: 

1. At the menu screen, touch Tools > Options. 
2. At the Options window, touch the Directories tab.  

 

Options window, Directories tab 
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3. To allow users to retrieve formula files, select Enabled for Formula Search. 

 

CAUTION 

After initial installation, you should not need to change the locations of the 
directories. Do not touch Reset Directories unless directed by Baxa 
Corporation Technical Support. Touching Reset Directories may result in 
damaged or lost data. 

4. If you want to change the locations of the directories, when directed by Technical 
Support: 

a. Touch Browse for Formula Files, Reports or Backups. 
b. Select the location of the directory. 

VIEWING THE BAXA OPTIONS 

You cannot edit the information on this tab; however, you may need to view it if directed by 
Baxa Corporation Technical Support. 

To access the Baxa options: 

1. At the menu screen, touch Tools > Options. 
2. At the Options window, touch the Baxa tab.  

 

Options window, Baxa tab 
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SETTING UP THE USERS 

Users are assigned to groups that have the appropriate permissions to perform the required 
tasks.  

WORKING WITH GROUPS 

Adding or Editing a Group 

IMPORTANT! These functions require Administration permissions.  

1. At the menu screen, touch Tools > Users > Edit Users and Groups. 

 

Edit Users and Groups window 

2. At the Edit Users and Groups window, in the top half, you may perform either of these 
actions: 

 To add a group, touch Add in the Groups section. 

The Add Group window appears. 

 To edit a group, select the group from the Name list, then touch Edit in the Groups 
section. 

The Edit Group <name> window appears. 
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Edit Group <name> window 

3. At the Add Group window or Edit Group <name> window, select the permissions for the 
group. 

IMPORTANT! These permissions will apply to an entire group of users. You cannot 
assign unique permissions directly to a user; however, you can create a group that 
contains only one user. 
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Permissions Allowed Functions Recommended  
Assignment 

Administration   Access the Windows desktop  

 Use Tools > Options  

 Use Tools > Users > Edit Users and 
Groups  

 Use the Inlet Editor 

 Use the Bag Inventory Editor 

Administrator 

Formulary  Use the Formulary Editor  

 Use the Ingredient Group Editor 

Administrator 

Edit 
Configuration  

Use the Configuration Editor Administrator 

Formula Edit Increase the Universal Ingredient (UI) 
volume to satisfy the flush requirement 

None 

 

WARNING 

Use of this permission for any 
user is discouraged. Because 
this permission allows a user 
to make changes to formulas, 
the clinical impact must be 
considered. 

 

Formula Entry  Create and save direct-entry formulas Administrator and Pharmacist 

Change 
Universal 
Ingredient 

Change the Universal Ingredient (UI) 
without changing the configuration  

Administrator, Pharmacist and Technician 

Verification  Perform cosignature authorization of 
the priming and verifying steps during 
setup  

Administrator and Pharmacist 
Tip! Baxa Corporation recommends having 
a pharmacist perform the verification. 

Compounder   Calibrate the load cell 

 Select the configuration 

 Change the tube set 

 Prime the inlets 

 Calibrate the compounder 

 Compound the solution 

 Edit the source remainders 

Administrator, Pharmacist and Technician 

Report   View reports  

 Export reports  

 Print reports (except MixCheck 
Report)  

Administrator, Pharmacist and Technician 

4. Touch Save.  
5. At the Edit Users and Groups window, touch OK. 
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Deleting a Group 

IMPORTANT! This function requires Administration permissions. You cannot delete a group 
that contains users. 

1. At the menu screen, touch Tools > Users > Edit Users and Groups. 
2. At the Edit Users and Groups window, in the top half: 

a. Select the group to delete from the Name list. 
b. Touch Delete in the Groups section. 

3. At the Delete user group <name>? message, touch Yes to delete the group. 

 

Message 

4. At the Edit Users and Groups window, touch OK. 
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WORKING WITH USERS 

Adding or Editing a User 

IMPORTANT! These functions require Administration permissions.  

1. At the menu screen, touch Tools > Users > Edit Users and Groups.  

The Edit Users and Groups window appears. 

 

Edit Users and Groups window 

2. At the Edit Users and Groups window: 
a. In the top half, select the group from the Name list.  
b. In the bottom half, you may perform either of these actions: 

 To add a user, touch Add in the Users section. 

The Add User window appears. 

 To edit a user, select the user from the Login Name list, then touch Edit in 
the Users section. 

The Edit User <name> window appears. 
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Edit User <name> window 

3. At the Add User window or Edit User <name> window: 
a. Enter the Login Name. 
b. Enter the User Name. 

Tip! Baxa Corporation recommends using a short Login Name and full User 
Name. 

c. Select the Group to which the user is assigned.  
d. Touch Save. 

4. At the Edit Users and Groups window, touch OK. 

NOTE: The password will be the same as the Login Name until the user logs in and 
changes the password. 

Tip! Baxa Corporation recommends that new users log in and change their passwords 
immediately. Refer to Changing a Password on Page 127. 

Resetting a User’s Password 

IMPORTANT! This function requires Administration permissions.  

1. At the menu screen, touch Tools > Users > Edit Users and Groups.  
2. At the Edit Users and Groups window: 

a. In the top half, select the group from the Name list.  
b. In the bottom half, select the user from the Login Name list, then touch Edit in 

the Users section. 
3. At the Edit User <name> window: 

a. Touch Reset Password.  
b. Touch Save. 

4. At the Edit Users and Groups window, touch OK. 

NOTE: The password is reset to be the same as the Login Name until the user logs in and 
changes the password. 

Tip! Baxa Corporation recommends that users log in and change their passwords 
immediately after a password reset. Refer to Changing a Password on Page 127. 
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Deleting a User 

IMPORTANT! This function requires Administration permissions.  

1. At the menu screen, touch Tools > Users > Edit Users and Groups. 
2. At the Edit Users and Groups window: 

a. In the top half, select the group from the Name list.  
b. In the bottom half, select the user to delete from the Login Name list, then touch 

Delete in the Users section. 
3. At the Delete user <name>? message, touch Yes to delete the user. 

 

Message 

4. At the Edit Users and Groups window, touch OK. 

Changing a Password 

1. At the menu screen, touch Tools > Users > Change Password.  
2. At the Change Password window: 

a. Enter the Old password.  
b. Enter the new password.  
c. Enter the new password again to verify it.  
d. Touch OK. 

 

Change Password window 
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Logging in as a Different User 

1. At the menu screen, select Tools > Users > Change User.  
2. At the Login window: 

a. Enter a different Login name.  
b. Enter the Password.  
c. Touch Log In.  

 

Login window 
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USING THE CONFIGURATION EDITOR 

Use the Configuration Editor to manage the configurations. 

 

WARNING 

Before making any changes, contact Baxa Corporation Technical Support. Refer to 
Getting Help on Page 17. 

IMPORTANT! These functions require Edit Configuration permissions. For more information 
about user groups and permissions, refer to Setting Up the Users on Page 121. 

At the menu screen, touch Edit > Configuration Editor. 

 

Menu screen, Edit menu 
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The Edit Configurations window appears. It lists the available configurations and allows you to 
add, edit, copy or delete configurations. 

 

Edit Configurations window 

ADDING OR EDITING A CONFIGURATION 

 

WARNING 

A Baxa Corporation pharmacist must approve every new or edited configuration 
before it is placed into service. Before making any changes, contact Baxa 
Corporation Technical Support. Refer to Getting Help on Page 17. 

1. At the Edit Configurations window, you may perform any of these actions: 

 To add a configuration, touch Add. 

The Add Configuration window appears. 

 To edit a configuration, select the configuration, then touch Edit. 

The Edit Configuration <name> window appears. 

 To copy a configuration, select the configuration, then touch Copy. 

The Copy of <copied configuration name> window appears. 

NOTE: You can use the Copy option to make minor edits to an existing configuration 
and save it with a new name. 
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Add Configuration window 

2. Enter the Name of the configuration. 
3. Touch a port. 

The Edit Port <number> window appears. 
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Edit Port <number> window 

4. At the Edit Port <number> window: 
a. Select the Product to associate with the port. 

NOTE: For a product to appear in the list, it must first be in the formulary. Refer 
to Using the Formulary Editor on Page 137. 

b. Select the Prime Volume. You can leave the standard volume that is 
automatically selected, or select the minimum volume. 

Tip! Baxa Corporation recommends using the standard prime volume to ensure 
that the inlets are primed and any bubbles are removed. 

NOTE: The prime volume is used during setup of the compounder. This volume 
must be set for each product that is in each configuration. Auto-addition 
ingredients are always primed with the standard volume.  

c. If the selected product requires an ingredient flush after it is delivered, select the 
flush ingredient in the Flush With list and set the flush volume in the Volume 
field. 

NOTE: For example, to force a flush when lipids are pumped in a 3-in-1 bag, set 
the port with the appropriate flush ingredient and volume. Typically, the flush 
ingredient is the Universal Ingredient (UI), but it can be any ingredient in the 
configuration and the formula. Formulas containing the selected product to be 
flushed must include a minimum volume of the flush ingredient. 

d. Touch OK. 
5. Repeat Steps 3–4 for all the ports you want to use. 
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The configuration window now shows the product that is associated with each port. If 
you requested an ingredient flush for a product, the ingredient button includes a red 
downward arrow that represents the flush. If the ingredient is set to use the minimum 
prime volume, the ingredient button includes the letter M. 

 

Add Configuration window with products 

6. At the configuration window: 
a. Select the Universal Ingredient.  

NOTE: For the Universal Ingredient (UI) to appear in the list, it must first be 
specified as a UI in the Formulary Editor (refer to Adding or Editing an Ingredient 
on Page 139) and included in the configuration. Universal Ingredients must be 
assigned to ports 19–24; they cannot be assigned to ports 1–18. A port specified 
for the Universal Ingredient is labeled U. For commonly used ingredients such as 
the Universal Ingredient, you can set up an electronic Y-site (refer to electronic 
Y-site on Page 199). For help with setting up an electronic Y-site, contact your 
local Baxa Corporation Technical Support. 

b. Enter the Final Flush Volume. 

Tip! Each formula must include at least this volume of the Universal Ingredient. 
Baxa Corporation recommends using at least 30 mL. The minimum is 25 mL. 

c. If you want to specify ingredients for auto-addition, touch Auto-Additions. 
Otherwise, skip to Step 8. 

A list of ingredients that are available for auto-addition appears on the right side 
of the window.  

NOTE: For the ingredient to be listed as available for auto-addition, it must first 
be specified as an allowable auto-addition in the formulary. Refer to Using the 
Formulary Editor on Page 137. 
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Selecting auto-additions 

7.  To select auto-additions: 
a. Select the check box for each desired ingredient.  
b. To select a specific product or add an ingredient flush for the selected ingredient, 

touch Edit Selected. 
c. When you are finished, touch Return to Products.  

8. At the configuration window, touch Edit Sequence. 

NOTE: This option is available only for existing configurations. If you do not edit the 
sequence (pumping order), the compounder will use the sequence of the port numbers 
(1, 2, 3 and so on). 
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A sequential list of ingredients appears on the right side of the window. 

 

Editing the sequence 

9. To edit the sequence: 
a. Select an ingredient, then use the arrows to move it up or down in the sequence. 

 NOTE: If an ingredient is available for auto-addition, True appears in the Auto-
Add column in this ingredient’s row. 

b. When you are finished, touch Return to Products.  
10. At the configuration window, touch OK. 
11. At the Edit Configurations window, touch Close. 

 

WARNING 

A Baxa Corporation pharmacist must approve every new or edited 
configuration before it is placed into service. 

12. Print a Configuration Report for the new or edited configuration. Refer to Configuration 
Report on Page 164. For instructions on sending the Configuration Report, refer to 
Getting Help on Page 17. 
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DELETING A CONFIGURATION 

1. At the Edit Configurations window: 
a. Select one or more configurations you want to delete. 
b. Touch Delete. 

2. At the Delete configuration <name>? message, touch: 

 Yes to delete the configuration 

 Yes to All to delete all configurations selected in the Edit Configurations window 

NOTE: If only one configuration is selected, only one will be deleted. You cannot 
delete a configuration that is currently in use. 

 

Message 

3. At the Edit Configurations window, touch Close. 
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USING THE FORMULARY EDITOR 

Use the Formulary Editor to manage the ingredients and products in the formulary. 

 

WARNING 

Before making any changes, contact Baxa Corporation Technical Support. Refer to 
Getting Help on Page 17. 

IMPORTANT! These functions require Formulary permissions. For more information about user 
groups and permissions, refer to Setting Up the Users on Page 121. 

 

Menu screen, Edit menu 
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The Formulary Editor window appears. In the top half, the Name list identifies the ingredients 
that can be included in a formula. In the bottom half, the Product Name list identifies each 
Product Name, with its Drug ID, that is associated with the ingredient.  

Touching the Inlets button displays the Inlet Editor. For instructions on using this feature, refer 
to Using the Inlet Editor on Page 150. 

 

Formulary Editor window 
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WORKING WITH INGREDIENTS 

Adding or Editing an Ingredient  

1. At the Formulary Editor window, in the top half, you may perform either of these actions: 

 To add an ingredient, touch Add in the Ingredients section. 

The Add Ingredient window appears. 

 To edit an ingredient, select the ingredient from the Name list, then touch Edit in 
the Ingredients section. 

The Edit Ingredient <name> window appears. 

 
Add Ingredient window 

2. At the Add Ingredient window or Edit Ingredient <name> window: 
a. Enter the Name. 

Tip! Baxa Corporation recommends entering the name and concentration. 

b. Enter the Abbr (abbreviation). 

NOTE: The information entered in the Abbr field will appear on the ingredient 
button on the pump screen. 

c. Enter the Spec Gr (specific gravity). 
d. In the Groups list, select the group to which the ingredient belongs. For more 

information, refer to Using the Ingredient Group Editor on Page 145. 
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e. If desired, select one or more of these check boxes: 

 Warn If Manual Addition to make a message appear when a formula that 
includes this ingredient is used, but this ingredient is not in the current 
configuration 

 Can be used for Universal Ingredient to allow this ingredient to be used as a 
Universal Ingredient (UI) 

 Auto-addition to allow this ingredient to be added for temporary use at an 
open port 

f. Touch Save.  

Deleting an Ingredient 

1. At the Formulary Editor window, in the top half: 
a. Select one or more ingredients you want to delete from the Name list. 
b. Touch Delete in the Ingredients section. 

2. At the Delete ingredient <name>? message, touch: 

 Yes to delete the ingredient  

 Yes to All to delete all ingredients selected in the Formulary Editor window 

NOTE: If only one ingredient is selected, only one will be deleted. You cannot 
delete an ingredient that is currently associated with a product, ingredient 
group, configuration or formula. 

 

Message 
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Viewing an Ingredient’s Usage Information 

1. At the Formulary Editor window, in the top half: 
a. Select the ingredient you want to view from the Name list. 
b. Touch Contained In in the Ingredients section. 

A message with the ingredient’s current usage appears, including:  

 The groups to which the ingredient belongs 

 The products that contain the ingredient 

 The configurations and formulas that contain the ingredient 

2. At the Information message, touch OK. 

 

Message 

Setting the Calibration Ingredient 

The calibration ingredient is used for calibrating the compounder’s pump. 

 

WARNING 

A sterile water product is required as the calibration ingredient. If you think that the 
calibration ingredient needs to be changed, contact Baxa Corporation Technical 
Support. Refer to Getting Help on Page 17. 

Viewing the Calibration Ingredient 

1. At the Formulary Editor window, in the top half, touch Show Cal. Ingredient in the 
Ingredients section. 

The calibration ingredient is highlighted. 

2. Touch OK. 
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WORKING WITH PRODUCTS  

Adding or Editing a Product 

1. At the Formulary Editor window: 
a. In the top half, select the ingredient from the Name list.  
b. In the bottom half, you may perform either of these actions: 

 To add a product, touch Add in the Products section. 

The Add Product window appears. 

 To edit a product, select the product from the Product Name list, then touch 
Edit in the Products section. 

The Edit Product <name> window appears.  

 
Add Product window 

2. At the Add Product window or Edit Product <name> window: 
a. Enter the product’s Manufacturer. 

NOTE: The Ingredient Name field populates automatically with the ingredient 
name in the formulary. You cannot change this field. 

 

WARNING 

It is important to select the correct inlet type for the container. Selecting 
the incorrect inlet type can lead to occlusions and incorrect volume 
delivery, resulting in patient harm. For assistance, contact Baxa 
Corporation Technical Support. Refer to Getting Help on Page 17. 

b. Select the appropriate Inlet for the container. For information about the 
available inlet types, refer to Inlets on Page 15. 

c. Enter the Container Size. 
d. Scan the barcode to enter the Barcode ID. 
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NOTE: For items that do not have a Barcode ID from the manufacturer, you can 
enter the data manually or use the default value. A default value will be created 
based on the data in the other fields. 

Tip! Baxa Corporation recommends always using the barcode reader when 
possible. 

 

WARNING 

If a Drug ID is assigned to one product in the order-entry software, and 
that Drug ID is assigned to a different product in the compounder’s 
formulary, the compounder may pump the wrong ingredient. It is the 
user’s responsibility to ensure that Drug IDs are correctly and 
consistently assigned in both systems. 

e. Enter the Drug ID. 

NOTE: The Drug ID is used to identify products uniquely. In the United States, the 
Drug ID is usually the NDC. 

f. Enter the Max Hang Time. 

NOTE: This setting is the maximum amount of time the product can be attached 
to the compounder. The compounder displays a message if the product remains 
attached longer than the specified time. 

g. Select the product’s Container Type. 

NOTE: Source containers that can be used with the compounder are: 

 Bags 

 Bottles, vented or non-vented (500 mL or larger) 

 Vials (10–250 mL) 

 Luer syringes (60 mL only) 

If you plan to use a different syringe size, contact Baxa Corporation Technical 
Support. Refer to Getting Help on Page 17. 

h. If you want to change the Name, touch Regenerate Name.  

NOTE: The Name is used when the product’s barcode is printed. Based on the 
product information, the Name is generated automatically for new products. 

i. Touch Save.  

 

WARNING 

A second user should verify all added or edited products. Otherwise, an 
incorrect dose and patient harm may result. 
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Deleting a Product 

1. At the Formulary Editor window: 
a. In the top half, select the ingredient from the Name list. 
b. In the bottom half, select one or more products you want to delete from the 

Product Name list, then touch Delete in the Products section. 
2. At the Delete product <name>? message, touch: 

 Yes to delete the product from the ingredient 

 Yes to All to delete all products selected in the Formulary Editor window 

NOTE: If only one product is selected, only one will be deleted. You cannot 
delete a product that is currently used in a configuration. 

 

Message 

Viewing a Product’s Usage Information  

1. At the Formulary Editor window: 
a. In the top half, select the ingredient from the Name list. 
b. In the bottom half, select the product you want to view from the Product Name 

list, then touch Contained In in the Products section. 

A message with the product’s current usage appears, including: 

 The configurations that contain the product 

 The solutions that contain the product 

2. At the Information message, touch OK. 

 

Message 
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USING THE INGREDIENT GROUP EDITOR 

Use the Ingredient Group Editor to assign the products that are in the formulary to the correct 
groups and specify which groups are incompatible. 

 

WARNING 

Before making any changes, contact Baxa Corporation Technical Support. Refer to 
Getting Help on Page 17. 

 

 

WARNING 

Any calcium-containing products must be assigned to the calcium members group, 
and any phosphate-containing products must be assigned to the phosphate members 
group to ensure the software will warn users about formulas that may cause a 
precipitate in the tube set during the compounding process. 

IMPORTANT! These functions require Formulary permissions. For more information about user 
groups and permissions, refer to Setting Up the Users on Page 121. 

At the menu screen, touch Edit > Ingredient Group Editor. 

 

Menu screen, Edit menu 
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The Ingredient Groups window appears. It lists the available ingredient groups and allows you 
to add, edit or delete ingredient groups. Calcium and Phosphate groups are created 
automatically. 

 

Ingredients Groups window 
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ADDING OR EDITING AN INGREDIENT GROUP 

1. At the Ingredient Groups window, you may perform either of these actions: 

 To add an ingredient group, touch Add. 

The Add Ingredient Group window appears. 

 To edit an ingredient group, select the ingredient group, then touch Edit. 

The Edit Ingredient Group <name> window appears.  

 

Edit Ingredient Group <name> window 

2. Enter the Name of the group.  
3. Specify the members of this group. 

 To add an ingredient to this group: 
a. Select the ingredient in the Nonmembers list. 
b. Touch >> to move the ingredient to the Members list. 

 To remove an ingredient from this group: 
a. Select the ingredient in the Members list. 
b. Touch << to move the ingredient to the Nonmembers list.  
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4. Specify the groups that are incompatible with this group. 

 To make another group incompatible with this group: 
a. Select the other group in the Compatible Groups list. 
b. Enter a Flush Volume. 

NOTE: The flush ingredient will be any ingredient that is not listed as 
incompatible. 

c. Touch >> to move the group to the Incompatible Groups list.  

 To make another group compatible with this group: 
a. Select the other group in the Incompatible Groups list. 
b. Touch << to move the group to the Compatible Groups list.  

5. To modify the flush volume for an incompatible group: 
a. Select the group in the Incompatible Groups list. 
b. Edit the Flush Volume. 
c. Touch Modify Flush.  

6. Touch Save.  
7. At the Ingredient Groups window, touch Close. 
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DELETING AN INGREDIENT GROUP 

1. At the Ingredient Groups window: 
a. Select one or more ingredient groups you want to delete. 
b. Touch Delete. 

2. At the Delete ingredient group <name>? message, touch: 

 Yes to delete the ingredient group 

 Yes to All to delete all ingredient groups selected in the Ingredient Groups 
window 

NOTE: If only one ingredient group is selected, only one will be deleted. You 
cannot delete an ingredient group that contains ingredients. 

 

Message 

3. At the Ingredient Groups window, touch Close. 
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USING THE INLET EDITOR 

The Inlet Editor allows you to manage the inlets that are available for use on the compounder. 

 

WARNING 

Do not make any changes unless directed by Baxa Corporation Technical Support. 
Changes may affect the delivery of ingredients. If you think that an inlet needs to be 
added, edited or deleted, contact Technical Support. Refer to Getting Help on 
Page 17. 

IMPORTANT! These functions require Administration permissions. For more information about 
user groups and permissions, refer to Setting Up the Users on Page 121. 

At the menu screen, touch Edit > Inlet Editor. 

 

Menu screen, Edit menu 
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USING THE BAG INVENTORY EDITOR 

The Bag Inventory Editor allows you to manage the bags that are available for use on the 
compounder. 

 

WARNING 

Do not make any changes unless directed by Baxa Corporation Technical Support. 
If you think that a bag needs to be added, edited or deleted, contact Technical 
Support. Refer to Getting Help on Page 17. 

IMPORTANT! These functions require Administration permissions. For more information about 
user groups and permissions, refer to Setting Up the Users on Page 121. Use only bags validated 
by Baxa Corporation for use with the compounder. For details, refer to Bags on Page 16. Using 
non-validated bags voids all manufacturer warranties. In addition, the accuracy of the finished 
solution will not be validated. 

At the menu screen, touch Edit > Bag Inventory Editor. 

 

Menu screen, Edit menu 
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USING REPORTS 

The compounder offers standard reports that document compounding activity and support 
various utilities. All reports are formatted for printing on standard-size paper. 

IMPORTANT! Viewing, printing and exporting reports requires Report permissions. For more 
information about user groups and permissions, refer to Setting Up the Users on Page 121. 

NOTE: To select the printer used for printing reports, refer to Report Printer on Page 116. 

To view reports: 

1. At the menu screen, select Reports > Standard.  

 

Menu screen, Reports menu 
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2. Select the report you want to view. 

NOTE: If reports are not listed, the directory for reports is not set up correctly. Refer to 
Setting Up the Directories Options on Page 119. 

 

Standard reports 

3. View the report. Refer to the instructions on the upcoming pages. 

NOTE: The report screen may include scroll bars on the right side and/or the bottom. 
The top of the report screen may include these navigation options: 

 The print icon allows you to send the report to the specified printer. 

 The export icon allows you to save the report to a USB drive. 

 The refresh icon generates the report again. 

 The percentage list controls the zoom. 

 The arrows and the number field allow you to move to different pages of a multi-
page report. 

4. When you are finished using the report, touch Exit. 

 

Navigation options for reports 

Refresh icon 

Print icon 

Export icon 
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MIXCHECK REPORT 

The MixCheck Report provides details about the compounding process for an order. It reports 
information including the expected bag weight, measured bag weight, ordered ingredients, 
ordered volumes and manual additions that are required. 

Customizing MixCheck Reports 

These options are available for customizing the MixCheck Report: 

 To make this report display and/or print automatically after compounding, and/or allow 
on-screen authorization, refer to MixCheck Report on Page 112. 

 To allow exporting of this report directly to the DoseEdge System, refer to MixCheck 
Data Export on Page 114. 

 To specify signature-related text that you want to include at the end of the report, refer 
to MixCheck Signature Label on Page 116. 

Using MixCheck Reports 

 

WARNING 

It is important to print a MixCheck Report for every order, then have a cosigner 
(pharmacist) view and approve the entire report, especially the Formula Name; 
Expected Weight, Measured Weight and Difference; Manual Additions; and 
Details. 

For instructions on viewing and approving the MixCheck Report, refer to the following pages. 
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Sample MixCheck Report 
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Sample MixCheck Report (left side) 

Verify that the Serial Number (unique for each 
order) matches the serial number on the label of 
the patient bag. 

Verify that the Formula Name matches the 
patient name on the label on the patient bag. 

If Manual Additions are listed: 
1. Verify that they match the label on the patient 

bag and/or the original formula. 
2. Add these ingredients to the solution manually. 
3. Place your initials in the Added column* on the 

right side of the page. 

Evaluate the information in the Details section to 
verify that the solution was compounded 
correctly. This section lists any interruptions that 
occurred while compounding, such as ingredient 
changes, ingredient replacements, occlusions, 
bubbles and other interruptions. 

 

WARNING 

It is important to have a pharmacist 
view and approve this information. 

 

In the signature-related section at the end of the 
report, follow your facility’s protocol. 
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Sample MixCheck Report (right side) 

Verify that the Date/Time matches the date and 
time the order was fulfilled. 

Compare the Measured Weight of the solution to 
the Expected Weight. Verify that the Difference is 
within acceptable limits per your facility’s protocol. 
 
NOTE: This example is shown to reinforce the 
importance of information included in this report. 

Verify that each ingredient and its Ordered Volume 
match the label on the patient bag and/or the 
original formula. 

Verify that the Total (mL) matches the label on 
the patient bag and/or the original formula. 

* If Manual Additions are listed, place your initials  
   in the Added column. 
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Viewing Old MixCheck Reports 

For information about the options that are available for customizing MixCheck Reports, refer to 
Customizing MixCheck Reports on Page 154. 

1. At the menu screen, touch Reports > MixCheck > Old MixCheck Data. 
2. At the Solutions window: 

a. Select a formula. 
b. Touch one of these buttons: 

 View MixCheck to view the report on the screen 

 Print MixCheck to send the report to the assigned printer 

 Export MixCheck Data (not shown below) to export the data to the 
DoseEdge System 

 

Solutions window 
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AUTHORIZATION REPORT  

The Authorization Report contains information about the compounder setup, including: 

 The user who set it up (in the Assembled column) and the optional cosigner who 
performed the verification (in the Verified column) 

NOTE: Users can print the report and write their initials in these columns, or the 
software can be set up to populate these columns automatically. 

 The ingredient name, port and inlet used during setup 

These options are available for customizing the Authorization Report: 

 To require a cosigner to verify the setup, refer to Cosignature on Page 118. 

 To make the Assembled and Verified columns populate automatically, refer to 
Authorization Report on Page 112. 

 To specify signature-related text that you want to include at the end of the report, refer 
to Authorization Report Signature Label on Page 116. 

To view the Authorization Report, touch Reports > Standard > Authorization at the menu 
screen. 

 

Sample Authorization Report 
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FORMULA REPORT 

The Formula Report is a summary of a specific formula. This report includes a delivery count for 
formulas that have been pumped multiple times. 

To view the Formula Report: 

1. At the menu screen, touch Reports > Standard > Formula. 
2. At the Select Formula window: 

a. Select Show All Formulas, or select another filter to reduce the number of 
formulas displayed.  

NOTE: The default filter is Show Unpumped Formulas. You can touch Formula 
Name to sort by name or touch Serial Number to sort by number.  

b. Select a formula.  
c. Touch OK.  

 

Select Formula window 
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Sample Formula Report 
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LOG REPORT  

The Log Report is a summary of the formulas that were used for compounding on a specific day.  

To view the Log Report: 

1. At the menu screen, touch Reports > Standard > Log.  
2. At the Enter Parameter Values window: 

a. Enter the date for the report in the Discrete Value field. 
b. Touch OK.  

 

Enter Parameter Values window 

NOTE: Depending on the number of formulas that are used for compounding each day, this 
report may be lengthy. 
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Sample Log Report 
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CONFIGURATION REPORT 

The Configuration Report provides information about a specific configuration.  

To view the Configuration Report: 

1. At the menu screen, touch Reports > Standard > Configuration.  
2. At the Select Configuration window: 

a. Select the configuration. 
b. Touch OK.  

 

Select Configuration window 
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Sample Configuration Report 
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FORMULARY REPORT 

The Formulary Report lists the ingredients that are included in the formulary. 

To view the Formulary Report, touch Reports > Standard > Formulary at the menu screen. 
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Sample Formulary Report 
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PRODUCT BAR CODES REPORT 

The Product Bar Codes Report displays the barcodes for products that are in the formulary. You 
can print the report onto labels for use with products that do not have a manufacturer’s 
barcode.  

For more information about printing, refer to Printing Options on Page 14. 

To view the Product Bar Codes Report: 

1. At the menu screen, touch Reports > Standard > Product Bar Codes.  
2. At the Select Product window: 

a. Select the product. 
b. Touch OK.  

 

Select Product window 
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Sample Product Bar Codes Report 
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INLET BAR CODES REPORT 

The Inlet Bar Codes Report displays the barcodes for the inlets. You can print the report onto 
labels if you need an extra barcode label.  

For more information about printing, refer to Printing Options on Page 14. 

To view the Inlet Bar Codes Report, touch Reports > Standard > Inlet Bar Codes at the menu 
screen. 
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Sample Inlet Bar Codes Report 
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BLACKBOX REPORT 

The Blackbox Report is a chronological list of all important system activity for a specific period 
of time. If necessary, Baxa Corporation may use this information for troubleshooting. 

To view the Blackbox Report: 

1. At the menu screen, select Reports > Standard > Blackbox.  
2. At the Enter Begin and End Times window: 

a. Enter the starting and ending times for the report. 
b. Touch OK. 

 

Enter Begin and End Times window 

Tip! Due to the amount of data collected, this report may be lengthy. Baxa Corporation 
recommends contacting Technical Support. Refer to Getting Help on Page 17. 
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Sample Blackbox Report 



Using Reports 

Operator Manual for the Baxa EXACTAMIX 2400 Compounder 
Page 174 5300-0769 Rev. P 

CALIBRATION SUMMARY REPORT  

The Calibration Summary Report summarizes the calibration processes for the pump and the 
load cell during a specific period of time. It also distinguishes between automatic and manual 
calibrations. 

To view the Calibration Summary Report: 

1. At the menu screen, touch Reports > Standard > Calibration Summary.  
2. At the Enter Parameter Values window: 

a. Enter the starting and/or ending dates for the report. 
b. If desired, select: 

 No lower bound to leave the starting date open-ended 

 No upper bound to leave the ending date open-ended 

NOTE: The available dates are still limited by the amount of time this information 
is stored. For more information, refer to Storage on Page 114.  

c. Touch OK. 

 

Enter Parameter Values window 
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Sample Calibration Summary Report 
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FORMULA PRECISION REPORT  

The Formula Precision Report summarizes the precision of the compounding process (how 
accurately the actual weight matched the expected weight) during a specific period of time.  

To view the Formula Precision Report: 

1. At the menu screen, touch Reports > Standard > Formula Precision. 
2. At the Enter Parameter Values window:  

a. Select Start_And_End_Dates and enter the starting and/or ending dates for the 
report. If desired, select: 

 No lower bound to leave the starting date open-ended 

 No upper bound to leave the ending date open-ended 

NOTE: The available dates are still limited by the amount of time this information 
is stored. For more information, refer to Storage on Page 114.  

b. Select Acceptable Weight Variance (%) and enter a value. 
c. Touch OK. 

 

Enter Parameter Values window 
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Sample Formula Precision Report 
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INGREDIENT USAGE REPORT  

The Ingredient Usage Report summarizes the ingredient usage during a specific period of time. 
This report can be used to help manage inventory. 

To view the Ingredient Usage Report: 

1. At the menu screen, select Reports > Standard > Ingredient Usage.  
2. At the Enter Parameter Values window: 

a. Select StartDay and enter a starting day for the report. 
b. Select EndDay and enter an ending day for the report. 
c. Touch OK. 

 

Enter Parameter Values window 
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Sample Ingredient Usage Report 



Using Reports 

Operator Manual for the Baxa EXACTAMIX 2400 Compounder 
Page 180 5300-0769 Rev. P 

BAG USAGE REPORT 

The Bag Usage Report summarizes the bag usage during a specific period of time. This report 
can be used to help manage inventory. 

To view the Bag Usage Report: 

1. At the menu screen, touch Reports > Standard > Bag Usage.  
2. At the Enter Parameter Values window: 

a. Enter the starting and/or ending dates for the report. 
b. If desired, select: 

 No lower bound to leave the starting date open-ended 

 No upper bound to leave the ending date open-ended 

NOTE: The available dates are still limited by the amount of time this information 
is stored. For more information, refer to Storage on Page 114.  

c. Touch OK. 

 

Enter Parameter Values window 
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Sample Bag Usage Report 
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FLOW FACTORS REPORT 

The Flow Factors Report lists the flow factors for all the ingredients in the current configuration. 

To view the Flow Factors Report, touch Reports > Standard > Flow Factors at the menu screen. 

 

Sample Flow Factors Report 
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TROUBLESHOOTING 

HANDLING INTERRUPTIONS AND ERRORS 

If you encounter any of these interruptions or errors, take the suggested actions. If the issue 
persists, contact Baxa Corporation Technical Support. Refer to Getting Help on Page 17. 

Issues with the Barcodes 

Issue / On-screen Text Possible Explanation Suggested Actions 

The label on the source 
container or the patient 
bag cannot be scanned. 
 
Text:  
Unable to scan 

The barcode on the label 
is not legible, or the 
barcode reader conflicts 
with a connected 
keyboard and/or mouse. 

1. Check that the green LED on the barcode 
reader illuminates and the barcode reader 
beeps when you scan a barcode. 

 If yes, continue with the next step. 

 If no, check that the cable for the barcode 
reader is connected correctly to the display, 
then skip to Step 3. 

2. Check whether a keyboard or mouse is 
connected. 

 If yes, disconnect the keyboard and/or 
mouse. They will conflict with the barcode 
reader. 

 If no, check that the barcode reader is 
enabled. Refer to Bar Code Reader on 
Page 118. If the compounder stops 
responding, reboot it. Refer to Rebooting 
and Shutting Down on Page 29. 

3. If the barcode on the source container or 
patient bag is not legible, replace the source 
container (Refer to Replacing a Source 
Container on Page 92.) or print and attach a 
new label for the patient bag. Do not scan any 
labels that are not on containers or bags 
attached to the compounder. 

Text: 
Incorrect Scan 

The barcode on the source 
container does not match 
the barcode value in the 
formulary. 

1. Contact your EXACTAMIX Administrator or 
Baxa Corporation Technical Support. Refer to 
Getting Help on Page 17. 

2. For help with correcting the barcode value, 
contact Baxa Corporation Technical Support. 
Refer to Getting Help on Page 17. 

3. When entering the Barcode ID for a new 
product, make sure that the information in the 
formulary matches the information on the 
container. Refer to Adding or Editing a Product 
on Page 142. 
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Issue / On-screen Text Possible Explanation Suggested Actions 

No barcodes can be 
scanned. 

The barcode reader does 
not indicate that it is 
operational. 

1. Disconnect the cable for the barcode reader 
from the display, then reconnect this cable. 

2. Check that the barcode reader and its cable are 
not damaged. 

3. If the cables for the keyboard and mouse are 
connected to the display, disconnect these 
cables. Then reboot the compounder. Refer to 
Rebooting and Shutting Down on Page 29. 

4. Contact Baxa Corporation Technical Support for 
a barcode programming sheet. Refer to Getting 
Help on Page 17. 

Text: 
Barcode reader (<serial 
number of .PAT file>): 
formula not found. 

The .PAT file is not 
available. 

1. Correct the .PAT file in the order-entry 
software. 

2. Reprint and attach the barcode label. 
3. Scan the barcode again. 
4. Check that the Ethernet cable is connected 

correctly to both the display and the order-
entry computer. 

5. Check that the network is functioning. 
6. Check the path on both the order-entry 

computer and the compounder. Refer to 
Setting Up the Directories Options on Page 119. 

7. Reboot the compounder. Refer to Rebooting 
and Shutting Down on Page 29. 

Text:  
Barcode reader (X): 
barcode contains an 
invalid Code 39 character.  

The barcodes for formulas 
must use the Code39 
symbology, which has a 
restricted character set.  

1. Ensure that the correct barcode is scanned. 
2. Reprint and attach the barcode label. 
3. Scan the barcode again. 

Text:  
Barcode reader (X): 
barcode contains an 
invalid MOD43 check 
digit.  

The barcodes for formulas 
must use the Code39 
symbology with a MOD43 
check digit appended.  

1. Ensure that the correct barcode is scanned. 
2. Reprint and attach the barcode label. 
3. Scan the barcode again. 
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Issues with the Formulas, Ingredients and Configurations 

Issue / On-screen Text Possible Explanation Suggested Actions 

Text: 
This formula contains 
<ingredient name>, which 
is not currently on the 
configuration. Do you 
wish to add it to the 
configuration?  

The ingredient is an auto-
addition ingredient.  

Add the ingredient. Refer to Performing an Auto-
Addition on Page 87. 

Text:  
Configuration must be 
verified before 
compounding.  

The configuration is not 
primed and verified. 

Prime and verify the configuration. Refer to Priming 
and Verifying on Page 55. 

Text:  
The following ports 
contain products that 
have been spiked longer 
than allowed. Port 
Product Time Spiked 
Allowed Hang Time 
(Hours) <list of products>. 

One or more ingredients 
have been attached longer 
than the allowed time. 

1. Touch Cancel. 
2. Replace the source container of each expired 

ingredient. Use aseptic technique. Refer to 
Attaching the New Ingredients and Inlets on 
Page 45. 

3. Prime and verify each expired ingredient. Refer 
to Priming and Verifying on Page 55. 

Text: 
Ingredient <ingredient 
name> must be manually 
added and its requested 
volume of <requested 
volume> mL exceeds the 
maximum manual add 
volume of <max manual 
add volume> mL. 

The product must be 
added manually, because 
it is not in the 
configuration, but its 
ordered volume exceeds 
the maximum volume for 
manual additions.  

 To continue with the manual addition, touch 
Manual Additions. 

 To cancel the order, touch Cancel.  
 
Also consider adding the ingredient to the 
configuration, so that this ingredient will not need 
to be handled as a manual addition. Refer to Adding 
or Editing a Configuration on Page 130. 

A Drug ID in the formula 
does not match any Drug 
ID in the formulary. 

If the product is in the configuration, check that the 
Drug ID is correct and that it matches the Drug ID 
from the order-entry software. Refer to Adding or 
Editing a Product on Page 142. 

Text: 
Swap Container: Your 
container of <ingredient 
name> is empty. You 
have <remaining volume> 
mL left to run. Please 
change the container 
now.  

The container is almost 
empty and needs to be 
replaced. 

Check that the container is almost empty. 

 If the container is almost empty, replace it. 
Refer to Replacing a Source Container on 
Page 92. 

 If the container is not almost empty, check that 
it is the correct container, and contact Baxa 
Corporation Technical Support. Refer to Getting 
Help on Page 17. 

During priming, the fluid 
does not flow through the 
expected inlet.  

The inlet is not attached 
to the correct port. 

1. Remove the source container from the vial rack 
or hanger and turn it right-side-up, to prevent 
fluid from flowing.  

2. Remove the inlet from the incorrect port and 
attach it to the correct port. 

3. Return the source container to the vial rack or 
hanger. 
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Issue / On-screen Text Possible Explanation Suggested Actions 

Text: 
Flushing with Universal 
Ingredient. Please attach 
flush/calibration bag.  

The tube set needs to be 
flushed prior to 
compounding. 

Attach a calibration bag and continue. Refer to 
Attaching and Removing the Calibration Bag on 
Page 43. Do not use a patient bag. 

Text: 
Formula Conflict:  
 
Formula contains  
incompatible ingredients 
with insufficient flush 
volume between them.  
 
First Ingredient: 
<ingredient name>  
 
Second Ingredient: 
<ingredient name>  
 
Required Flush: <required 
volume>  
 
Available Flush: 
<available volume>  
 
Solution must be 
canceled. 

There is not enough 
ingredient flush between 
incompatible ingredient 
groups. 

1. Touch Cancel. 
2. Contact Baxa Corporation Technical Support. 

Refer to Getting Help on Page 17. 
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Issue / On-screen Text Possible Explanation Suggested Actions 

Text: 
Formula Conflict: 
Additional <flush volume> 
mL of <Universal 
Ingredient> required for 
order. 

The formula does not 
contain the minimum 
required volume of the 
Universal Ingredient (UI). 

IMPORTANT! This function requires Change 
Universal Ingredient permissions. For more 
information about user groups and permissions, 
refer to Setting Up the Users on Page 121. 
1. Touch Change UI To…  
2. Touch OK. 

A Change Universal window appears. It lists any 
ingredients that are specified as a UI in the 
Formulary Editor (refer to Adding or Editing an 
Ingredient on Page 139), included at a UI port 
in the configuration (refer to Adding or Editing 
a Configuration on Page 130) and have an 
ordered volume that is sufficient for a UI. 

3. At the Change Universal window: 
a. Select the Universal Ingredient you want to 

use. 
b. Touch OK. 

 

WARNING 

Do not use a patient bag during 
Universal Ingredient flushes. 
Otherwise, the patient bag may 
contain an unintended volume and/or 
ingredient, resulting in patient harm. 

4. If a patient bag is attached, remove it. Refer to 
Removing the Patient Bag on Page 86. 

5. Attach a calibration bag. Refer to Attaching and 
Removing the Calibration Bag on Page 43. 

6. At the Flushing with Universal Ingredient 
message, touch OK.  

 

WARNING 

Do not touch OK at the Completed 
flushing message until after you 

attach the patient bag. Otherwise, the 
compounder will pump the formula 
ingredients into the calibration bag. 

7. When the Completed flushing message 
appears, remove the calibration bag. Refer to 
Attaching and Removing the Calibration Bag on 
Page 43. 

8. Attach the patient bag. Refer to Attaching the 
Patient Bag on Page 72. 

9. At the Completed flushing message, touch OK. 
10. Repeat the compounding process. 

Text: 
Calibration ingredient not 
found in configuration. 

The water product 
(for example, the 
manufacturer or container 
size of dextrose) may have 
changed recently. 

1. Check that the calibration ingredient is set 
correctly. Refer to Setting the Calibration 
Ingredient on Page 141.  

2. If it is set correctly, contact Baxa Corporation 
Technical Support for assistance. Refer to 
Getting Help on Page 17. 



Troubleshooting 

Operator Manual for the Baxa EXACTAMIX 2400 Compounder 
Page 188 5300-0769 Rev. P 

Issues with the Calibration 

On-screen Text Possible Explanation Suggested Actions 

Load cell not calibrated. 
Must calibrate to 
continue.  

The load cell is not 
calibrated. 

1. Touch Yes. 
2. Calibrate the load cell. Refer to Calibrating the 

Load Cell on Page 33. 

Span  
Calibration Out  
Of Range. Calibration 
failed. 

The calibration of the load 
cell is out of range. 
Something may be 
touching or interfering 
with the load cell. 

1. Check that:  

 The cable for the load cell is connected 
correctly. 

 The load cell is level and locked into place. 

 There is nothing (for example, the outlet 
tube, bag or cable for the load cell) touching 
the pan or base of the load cell. 

 There are no environmental factors (for 
example, air flow or vibrations) interfering 
with the load cell. 

2. Calibrate the load cell. Refer to Calibrating the 
Load Cell on Page 33. Read the on-screen 
messages carefully, and make sure that you do 
not place the calibration weight on the load cell 
too early. 

The pump has not been 
calibrated since the last 
tube set change. This 
operation must be 
completed prior to 
pumping a solution.  
 
Would you like to 
calibrate the pump now?  

The pump is not 
calibrated. 

1. Touch Yes. 
2. Calibrate the pump. Refer to Calibrating the 

Compounder on Page 67. 

Unable to measure stable 
weight 

The calibration of the 
pump failed. Something 
may be touching or 
interfering with the load 
cell. 

1. Check that:  

 The load cell is level and locked into place. 

 There is nothing (for example, the outlet 
tube, bag or cable for the load cell) touching 
the pan or base of the load cell. 

 There are no environmental factors (for 
example, air flow or vibrations) interfering 
with the load cell. 

2. Calibrate the compounder. Refer to Calibrating 
the Compounder on Page 67. 
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On-screen Text Possible Explanation Suggested Actions 

Pump calibration has 
failed. 

The calibration of the 
pump failed.  

1. Check that the valve set is installed correctly. 
Refer to Installing the New Valve Set on 
Page 41. 

2. For the source container of water, check the 
following conditions. Refer to Attaching the 
New Ingredients and Inlets on Page 45. 

 The correct inlet is used. 

 The inlet is not kinked. 

 The bag is spiked correctly. Refer to 
Page 49. 

3. Clean any spills near the pump rotor. 
4. Calibrate the load cell. Refer to Calibrating the 

Load Cell on Page 33. 
5. Calibrate the pump. Refer to Calibrating the 

Compounder on Page 67.  

Issues with the Weight and Load Cell 

On-screen Text Possible Explanation Suggested Actions 

Expected Weight: 
<calculated weight> gm  
 
Actual Weight: <actual 
weight> gm  
 
Difference: <weight 
difference>%  
 
The final weight of this 
solution is outside of the 
acceptable limit of +/-5% 
 
Possible Cause: Unknown  

The final bag weight is out 
of range. 
 
After the compounder 
delivers all the 
ingredients, the weight of 
the patient bag differs 
from the expected weight 
by more than the 
acceptable difference. 

1. On the MixCheck Report, check for suspect 
ingredients and references to occlusions and 
bubbles. Refer to MixCheck Report on 
Page 154.  

2. Calibrate the load cell. Refer to Calibrating the 
Load Cell on Page 33. 

3. Calibrate the compounder. Refer to Calibrating 
the Compounder on Page 67. 

4. If the issue persists, check that: 

 All the source containers are spiked 
correctly. Refer to the steps for spiking a 
container, starting on Page 49. 

 The rollers on the pump rotor are clean and 
move freely. Refer to Cleaning the 
Compounder on Page 100. 

 The tube set is installed correctly. Refer to 
Attaching the New Ingredients and Inlets on 
Page 45. 

5. Compound a large-volume solution with at 
least 205 mL of water to make the compounder 
calibrate automatically. 
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On-screen Text Possible Explanation Suggested Actions 

Expected Weight: 
<calculated weight> gm  
 
Actual Weight: <actual 
weight> gm  
 
Difference: <weight 
difference>%  
 
The final weight of this 
solution is within the 
acceptable limit of +/-5%, 
however some 
ingredients may not have 
delivered correctly.  
 
Possible Cause: 
<ingredient name> is 
possibly <underweight / 
overweight> by <weight 
error> grams  

Although the final bag 
weight is within range, an 
individual ingredient 
delivery is out of range. 
 
After the compounder 
delivers an individual 
ingredient, the weight of 
the patient bag differs 
from the expected weight 
by more than the 
acceptable difference.  
 
The compounder checks 
the bag weight after 
individual ingredient 
deliveries over 100 mL.  

1. Check that all the ingredients and inlets are 
correct. 

2. Check that the tube set is installed correctly. 
Refer to Installing the New Valve Set on 
Page 41 and Attaching the New Ingredients and 
Inlets on Page 45. 

3. On the MixCheck Report, check for references 
to occlusions and bubbles. Refer to MixCheck 
Report on Page 154.  

4. Check that all the source containers are spiked 
correctly. Refer to the steps for spiking a 
container, starting on Page 49. 

5. Check that the rollers on the pump rotor are 
clean and move freely. Refer to Cleaning the 
Compounder on Page 100. 

6. Calibrate the load cell. Refer to Calibrating the 
Load Cell on Page 33. 

7. Calibrate the pump. Refer to Calibrating the 
Compounder on Page 67. 

8. Contact Baxa Corporation Technical Support to 
check that the flow factors are correct. Refer to 
Getting Help on Page 17. 
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On-screen Text Possible Explanation Suggested Actions 

The bag currently on the 
load cell does not appear 
to be empty.  

Before pumping starts, the 
load cell detects that the 
destination bag contains 
fluid. 

If the bag contains fluid, and you are calibrating the 
compounder, refer to Step 4 on Page 68. 
 
If the bag contains fluid, and you are compounding 
the solution: 
1. Touch No. 
2. At the Operation Cancelled message, touch OK. 
3. If the attached bag is a patient bag, write a 

large “X” on the label. 
4. Remove the bag from the load cell. Depending 

on the type of the attached bag, refer to: 

 Removing the Patient Bag on Page 86 

 Attaching and Removing the Calibration Bag 
on Page 43 

5. Discard the bag. 
6. Attach an empty patient bag. Refer to 

Attaching the Patient Bag on Page 72. 
 
If the bag is empty: 
1. Touch No. 
2. At the Operation Cancelled message, touch OK. 
3. Remove the bag from the load cell. Depending 

on the type of the attached bag, refer to: 

 Removing the Patient Bag on Page 86 

 Attaching and Removing the Calibration Bag 
on Page 43 

4. Calibrate the load cell. Refer to Calibrating the 
Load Cell on Page 33. 

5. If necessary, attach the appropriate bag to the 
load cell. Refer to: 

 Attaching the Patient Bag on Page 72 

 Attaching and Removing the Calibration Bag 
on Page 43 

There does not appear to 
be a bag hung on the 
scale.  

The load cell detects that 
the destination bag is not 
attached. 

If the bag is not attached, attach the appropriate 
bag to the load cell. Refer to: 

 Attaching the Patient Bag on Page 72 

 Attaching and Removing the Calibration Bag on 
Page 43 

 
If the bag is attached: 
1. Touch No. 
2. Calibrate the load cell. Refer to Calibrating the 

Load Cell on Page 33. 
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Issues with the Pump 

On-screen Text Possible Explanation Suggested Actions 

Pump was paused.  The pump was paused 
during normal operation. 

1. If the pump door was opened, close it. 
2. Touch OK. 
3. Touch Resume to continue compounding. 

Pump door was opened. The pump door was 
opened during normal 
operation. 

1. Close the pump door. 
2. Touch OK. 
3. Touch Resume to continue compounding. 

Pump is faulted The pump door was 
opened during normal 
operation. 

1. Close the pump door. 
2. Touch OK. 
3. Touch Resume to continue compounding. 

Unable to start the pump 
because the pump is in a 
fault state 

The rotor was manually 
adjusted while the 
compounder was turned 
on. 

1. Touch OK. 
2. At the pump screen, touch Stop and follow the 

on-screen instructions. 
3. Reboot the compounder. Refer to Rebooting 

and Shutting Down on Page 29. 
4. Repeat the compounding process. 

Pump is in fault state and 
must be reset before use. 
Reset the pump?  

A pump fault occurred. Touch Yes to reset the pump.  

Pump faulted. Unable to 
close valve. Valve is 
moving.  

A system fault or power 
loss occurred.  

The compounding process cannot be completed. 
1. Write a large “X” on the label of the patient 

bag, then remove and discard the patient bag. 
2. Reboot the compounder. Refer to Rebooting 

and Shutting Down on Page 29. 
3. Repeat the compounding process. 

Issues with the Occlusion Detector / “Flow Sensor” 

NOTE: For all of these messages about the occlusion detector self-test, touching Cancel displays 
a Contact Baxa message and disables your ability to compound a solution or calibrate the 
compounder. 

On-screen Text Possible Explanation Suggested Actions 

The Occlusion Detector 
Test failed. 
Air detected in fluid 
pathway. 
 
Select OK to Retry. 
Select Cancel to Exit. 

The test failed because an 
air bubble was detected in 
the common fluid 
pathway. 

1. Touch Cancel. 
2. To help reduce the occurrence of bubbles and 

make their detection more accurate, refer to 
the note on Page 96. 

3. Contact Baxa Corporation Technical Support. 
Refer to Getting Help on Page 17. 

 
NOTE: To perform the test again, you must re-prime 
at least one inlet (other than the Universal 
Ingredient) and then exit the PRIME AND VERIFY 
screen. 

The Occlusion Detector 
Test failed. 
Pump door open. 
 
Select OK to Retry. 
Select Cancel to Exit. 

The test did not finish 
because the pump door 
was opened during the 
test. 

 

 

1. Close the pump door. 
2. Touch OK. The test occurs again. 
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On-screen Text Possible Explanation Suggested Actions 

The Occlusion Detector 
Test failed. 
Pump was paused. 
 
Select OK to Retry. 
Select Cancel to Exit. 

The test did not finish 
because the pump was 
paused during the test. 

Touch OK. The test occurs again. 

The Occlusion Detector 
Test failed. 
 
Select OK to Retry. 
Select Cancel to Exit. 

The test failed for an 
unknown reason. 

1. Check that the tube set is installed correctly. 
Refer to Installing the New Valve Set on 
Page 41 and Attaching the New Ingredients and 
Inlets on Page 45. 

2. Touch OK. The test occurs again. 

The Occlusion Detector 
Test did not run because 
the bubble test failed. 

The test did not start 
because an air bubble was 
detected or the outlet 
tube was not installed 
correctly. 

1. Touch Cancel. 
2. To help reduce the occurrence of bubbles and 

make their detection more accurate, refer to 
the note on Page 96. 

 
NOTE: To perform the test again, you must re-prime 
at least one inlet (other than the Universal 
Ingredient) and then exit the PRIME AND VERIFY 
screen. 

Cannot set flow sensor 
status:  

The compounder failed to 
set the status of the 
occlusion detector when 
starting to pump. 

Contact Baxa Corporation Technical Support. Refer 
to Getting Help on Page 17. 

The Occlusion Detector 
Test failed. 
Sensor failure. 
 
Select OK to retry 
Select Cancel to exit 

The test failed. The 
detector may have 
malfunctioned. 

Contact Baxa Corporation Technical Support. Refer 
to Getting Help on Page 17. 
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Other Issues 

Issue / On-screen Text Possible Explanation Suggested Actions 

The compounder does not 
power up. 

The power cord or the 
cable for the display is 
disconnected. 

1. Check that the power cord is connected to the 
main module and the power source. 

2. Check that the cable for the display is 
connected correctly to both the display and the 
main module. 

The power source is not 
functional. 

Connect the power cord to another power source. 

The screen of the display 
does not respond to 
touch. 

The cable for the display is 
disconnected. 

1. Check that the cable for the display is 
connected correctly to both the display and the 
main module. 

2. Disconnect the cables for the mouse and 
keyboard from the display. 

3. Reboot the compounder. Refer to Rebooting 
and Shutting Down on Page 29. 

The network is 
unavailable.  

There is a problem with 
the hospital network. 

1. Check that the Ethernet cable is connected to 
the Ethernet port on the bottom of the display. 

2. Load the formula by connecting a USB drive. 
Refer to Loading a Formula by Connecting a 
USB Drive on Page 196. 

The MixCheck Report does 
not print. 

The printer is 
disconnected or turned 
off. 

Check that the printer is connected and turned on. 

Printing was cancelled 
inadvertently. 

 Check that the MixCheck Report is available 
when you print old MixCheck Reports. Refer to 
Viewing Old MixCheck Reports on Page 158.  

 Be aware that the message about the MixCheck 
Report being printed appears after you touch 
OK at the message about the final weight. If you 
quickly touch more than once, you might 
inadvertently touch Cancel Printing.  

The path to the printer is 
not set up correctly. 

Check the path to the printer. Refer to Setting Up 
the Directories Options on Page 119. 

Text: 
An unknown pump 
error/valve error 
occurred  

An internal software error 
occurred.  

Contact Baxa Corporation Technical Support. Refer 
to Getting Help on Page 17. 

Text: 
Bad file format  

The .PAT file being read 
does not match the 
expected format.  

Create a new order in the order-entry software. 

Text: 
Cancellation in progress. 
Solution will need to be 
discarded. Continue?  

During the compounding 
process, a necessary 
container replacement 
was cancelled.  

1. Touch Continue. 
2. Write a large “X” on the label of the patient 

bag, then remove and discard the bag.  

Text: 
Cannot resume: Pump is 
faulted 

The pump failed to 
resume compounding. 

1. Reboot the compounder. Refer to Rebooting 
and Shutting Down on Page 29. 

2. Contact Baxa Corporation Technical Support. 
Refer to Getting Help on Page 17. 

Text: 
Cannot resume: Pump is 
deenergized 

The pump failed to 
resume compounding.  

1. Reboot the compounder. Refer to Rebooting 
and Shutting Down on Page 29. 

2. Contact Baxa Corporation Technical Support. 
Refer to Getting Help on Page 17. 
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Issue / On-screen Text Possible Explanation Suggested Actions 

Text: 
Compounder connection 
not established. Must 
connect to continue.  

The cable for the display is 
disconnected or damaged. 

Check that the cable for the display is connected 
correctly to both the display and the main module, 
and that the cable is not damaged. 

Text: 
No Pump Device Assigned  

A software error occurred. 1. Shut down the compounder. Refer to 
Rebooting and Shutting Down on Page 29. 

2. Reconnect the cord and cables. Refer to Step 6 
on Page 20. 

3. Turn the compounder on. Refer to Starting Up 
and Logging In on Page 26. 

Text: 
No Scale Device Assigned  

A software error occurred. 1. Shut down the compounder. Refer to 
Rebooting and Shutting Down on Page 29. 

2. Reconnect the cord and cables. Refer to Step 6 
on Page 20. 

3. Turn the compounder on. Refer to Starting Up 
and Logging In on Page 26. 

Text: 
No Valve Device Assigned  

A software error occurred. 1. Shut down the compounder. Refer to 
Rebooting and Shutting Down on Page 29. 

2. Reconnect the cord and cables. Refer to Step 6 
on Page 20. 

3. Turn the compounder on. Refer to Starting Up 
and Logging In on Page 26. 

Text: 
Password (X) contains an 
invalid character  

Passwords can contain 
only the letters A–Z and 
numbers 0–9.  

Correct the password. Refer to Changing a Password 
on Page 127. 

Text:  
Time out.  

A hardware 
communication error 
occurred. 

1. Shut down the compounder. Refer to 
Rebooting and Shutting Down on Page 29. 

2. Check that the cord and cables are connected 
correctly. Refer to Step 6 on Page 20. 

3. Turn the compounder on. Refer to Starting Up 
and Logging In on Page 26. 

Text: 
Unable to save current DB  

The current database 
cannot be saved. There 
may be a hard drive 
failure, missing directory, 
network failure (if the 
destination is on a 
network drive) or issue 
with permissions. 

Contact Baxa Corporation Technical Support. Refer 
to Getting Help on Page 17. 

Text: 
Valve is moving. 

A port cannot be closed. Reboot the compounder. Refer to Rebooting and 
Shutting Down on Page 29. 
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LOADING A FORMULA BY CONNECTING A USB DRIVE 

Some facilities may use this method if they use order-entry software but the network is 
temporarily unavailable. For help with using this method, contact Baxa Corporation Technical 
Support. Refer to Getting Help on Page 17. 

IMPORTANT! This method requires: 

 Formula Entry permissions. For more information about user groups and permissions, 
refer to Setting Up the Users on Page 121. 

 Order-entry software on a separate computer. This software must be able to produce 
both a .PAT file and a corresponding label with a barcode. Both the .PAT file and 
barcode must be compatible with the compounder. ABACUS Software meets these 
requirements. For more information, or if a barcode cannot be printed, contact Baxa 
Corporation Technical Support. Refer to Getting Help on Page 17. 

 USB drive 

NOTE: Be sure that the USB drive is free of viruses. 

 Barcode reader at the compounder 

In the order-entry software, the pharmacist creates an order, which creates a .PAT file that 
contains the patient information and the formula. The pharmacist saves the order onto a USB 
drive. Refer to Transferring Patient (.PAT) Files to the EXACTAMIX Compounders when the 
Network is Unavailable on Page 204. A corresponding label with a barcode also prints at the 
same time. Typically, a technician applies this label to a new patient bag and brings it to the 
compounder. However, this process depends on your facility’s protocol. 

At the compounder: 

1. Connect the USB drive to a USB port on the bottom of the display. 
2. Set up the software to look for formula files on the USB drive. For instructions, refer to 

Setting Up the Directories Options on Page 119. 

NOTE: The software will continue to look for formula files in this location until you 
change it back to the original location.  

3. Scan the barcode on the label of the patient bag. 

The compounder retrieves the order file from the USB drive and populates the pump 
screen with the name and volume of each ingredient to be pumped. 

4. Continue with Fulfilling the Order (Basic Process) on Page 81. 
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RESTORING THE DATABASE 

If certain types of issues occur, Baxa Corporation Technical Support may ask you to restore the 
database. 

1. At the menu screen, touch Tools > Database > Restore Database.  
2. At the Do you wish to backup message, touch Yes. 

 

Message 

3. At the Backup Database Location window: 
a. If desired, change the location of the backup by touching the button to the right 

of the current location (not recommended). 
b. Check Overwrite Existing File? to replace the previous backup file.  
c. Touch OK.  

 

Backup Database Location window 

4. At the Backup succeeded message, touch OK. 

 

Message 
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5. At the Restore Database Location window: 
a. If desired, change the location of the backup you want to restore by touching the 

button to the right of it.  
b. Touch OK. 

 

Restore Database Location window 

6. At the Database restored successfully message, touch OK. 

The compounder is now ready to use the restored database. 

 

Message 
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GLOSSARY 

Use this glossary to help you understand any terms that may be unfamiliar.  

Term Definition 

acceptable weight variance The percentage by which the final weight of the compounded solution, 
or the weight of an ingredient delivery, is allowed to differ from the 
expected weight. You can specify the variance. 

alarm An audible tone that indicates an error state. 

auto-addition An option that allows you to add an ingredient to the existing 
configuration when needed, instead of selecting a new configuration 
(which would require you to prime and verify all the inlets and 
ingredients). 

backup The process and result of saving database information to a location 
other than the compounder. 

base plate The common base on which the compounder’s components sit. 

Blackbox data The logged activities of the compounder, mainly based on the 
communication between software, firmware and user actions. 

common fluid pathway The area from the port through the valve set to the destination bag. One 
or more ingredients can be present in this area. 

compounder The complete device with all of its hardware components and software, 
excluding the tube set and bags. 

compound / compounding The process of pumping ingredients into a patient bag. 

configuration A designation of the products that will be attached to the ports, the 
sequence in which they will be pumped, any allowable auto-additions, 
the ingredient and volume to use for any ingredient flushes, the 
Universal Ingredient (UI) and the volume to use for the final flush. 

daily setup The process of attaching all the ingredients for a specific configuration to 
the compounder and preparing to compound solutions. Includes 
calibrating the load cell, priming, verifying and calibrating the 
compounder. 

daily use components The disposable components (tube set) and destination bags. 

database Information containing operating parameters, the formulary and other 
definable variables to be used by the compounder. 

deliver / delivering The act of pumping ingredients from a source container to the 
destination bag. 

delivery A single, measured volume of fluid that has been pumped into the 
destination bag. 

destination bag A sterile container that holds the fluid pumped from the source 
containers. It can be a patient bag (used for delivering the finished 
solution to a patient) or a calibration bag (used for collecting any fluid 
that is not intended for a patient). 

direct entry mode A mode where you enter a formula manually by specifying the ingredient 
and volume to be delivered from each port.  

display The touch-screen display for the user interface. It mounts to the base 
plate. 

disposables See tube set. 

dose A specific volume and concentration of an ingredient.  

electronic Y-site A setup option that allows you to attach the same ingredient to multiple 
ports, to improve the efficiency of pumping common ingredients. When 
the first container of this ingredient has emptied, the compounder 
continues pumping from the next container of this ingredient. 
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Term Definition 

equivalent ingredient products Products of the same ingredient type that may have different container 
sizes, container types or manufacturers.  

final flush A delivery of fluid that is pumped to clear all delivered ingredients from 
the common fluid pathway, to ensure that these ingredients are fully 
present in the finished solution. The fluid used for this flush is always the 
Universal Ingredient (UI). The standard volume is 30 mL. 

finished solution The ingredients in the patient bag after compounding, including manual 
additions. 

flow factor A value associated with each ingredient that compares the flow of that 
ingredient to the flow of water. The flow factor accounts for the 
ingredient’s viscosity, the size and type of its source container, its inlet, 
its venting and other factors that affect its delivery. The flow factor is 
critical to performance and should not be modified without contacting 
Baxa Corporation Technical Support. 

fluid pathway See common fluid pathway.  

flush See final flush, ingredient flush or intermediate flush.  

formula A recipe of ingredients to be compounded. Typically, it is created by the 
pharmacist, based on a prescription from a physician.  

formulary The list of ingredients, and associated products, which can be attached 
to the compounder.  

incompatible group A group of ingredients that you identify as having interaction concerns 
with other ingredients.  

ingredient A solution of a specific chemical entity at a specific concentration, 
regardless of the container size, container type or manufacturer. One 
ingredient can have several associated products. 

ingredient flush A delivery of fluid that is pumped to clear the common fluid pathway 
between the delivery of certain ingredients that have interaction 
concerns. The fluid used for this flush is usually the Universal Ingredient 
(UI), but it can be any compatible ingredient in the configuration and 
formula.  

ingredient group A list of chemically similar ingredients, used for defining incompatible 
groups. 

initial setup The placement and assembly of the product components at the 
customer facility by Baxa Corporation personnel.  

inlet A sterile tube with a spike or Luer end attached. The spike or Luer end 
attaches to a source container, and the other end attaches to a port on 
the valve set. 

intermediate flush A delivery of fluid that comes just before the final flush as part of an 
enhanced flush. The fluid used for this flush is always the Universal 
Ingredient (UI), and it is pumped in two deliveries of 50 mL each. 

large-volume delivery See macro ingredient. 

load cell The component that holds the destination bag, weighs the compounded 
solution and reports the measurement to the software. It mounts to the 
base plate. 

macro ingredient A generic term used to describe an ingredient that uses a large-bore inlet 
and is delivered in volumes equal to or greater than 5 mL. 

main module The component that contains the valve actuators, occlusion detector, 
bubble detector, pump chamber and power supply. It mounts to the 
base plate. 

maintenance The act of performing scheduled or expected work on the compounder. 
It does not include repairs or corrections due to product failure. 

manual addition A product that is added to the compounded solution manually, after 
compounding has finished. 
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Term Definition 

micro ingredient A generic term used to describe an ingredient that uses a micro inlet and 
is delivered in volumes less than 5 mL. 

National Drug Code (NDC) A unique, three-segment number used in the United States to identify 
drug products used by humans. 

occlusion A blockage in the fluid pathway. 

outlet tube The section of tube on the discharge side of the valve set. It connects the 
valve set to the destination bag. 

Parenteral Nutrition (PN) A form of intravenous therapy that requires multiple fluid ingredients to 
be accurately compounded into a single solution to support a patient’s 
nutritional needs.  

.PAT file A file, created in the order-entry software, which contains the patient 
information and formula. 

patient The recipient of the finished solution. 

permissions The privileges granted to groups of users to allow them to perform 
specific functions. 

port The interface between the valve set and the inlets for source containers. 

prime To pump a small volume of an ingredient through an inlet, to remove air 
bubbles from the inlet and prepare it for compounding the solution. 

privileges See permissions. 

product An ingredient in a particular container size and type from a specific 
manufacturer. Several products can be associated with one ingredient. 

pump A peristaltic device used to push fluid through the outlet tube. 

pump module See main module. 

remainder A value in the software that represents the actual volume of fluid 
remaining in the source container. 

scale See load cell. 

sequence The order in which ingredients are delivered to the destination bag. 

solution The mixture of ingredients that have been compounded. 

small-volume delivery See micro ingredient. 

source container A container (bag, bottle, vial or syringe) that holds one ingredient. 

tolerance The amount by which any characteristic (for example, dimensional, 
chemical, physical or mechanical properties) may vary from that 
specified.  

tube set The valve set and inlets. 

Universal Ingredient (UI) The ingredient that is used to flush the common fluid pathway. This 
ingredient must be contained in the configuration and the formula being 
compounded.  

unload The precaution of removing a formula from the pump screen when you 
navigate away from this screen. Unloading does not delete the formula 
from the database. 

user accounts The accounts that contain the user names, user permissions and other 
attributes as determined by the facility.  

valve set A sterile, multiple-port valve with an outlet tube attached. The valve 
body fits over the valve actuators on the compounder, protecting them 
from damage. The outlet tube attaches to the destination bag. 

variance One measure of statistical dispersion, averaging the squared distance of 
its possible values from the expected value (mean).  

volume The physical amount of the ingredient that is delivered, typically in 
milliliter (mL) units.  
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APPENDIX A: SPECIFICATIONS 

DIMENSIONS, WEIGHT AND CONTENTS OF THE DISPLAY  

 DX Display DY Display 

Dimensions and weight: Length: 11 in. (27.9 cm) 
Width: 5 in. (12.7 cm) 
Height: 9 in. (22.9 cm) 
Weight: 10 lb (4.5 kg) 

Length: 12.2 in. (31 cm) 
Width: 2.1 in. (5.3 cm) 
Height: 9.6 in. (24.2 cm) 
Weight: 8 lb (3.6 kg) 

Operating software:  Windows XP, embedded Windows, embedded standard 2009 

CPU: Pentium II 266 MHz minimum Intel Atom Z5xxP 1.1 Ghz 

Memory: 64 MB minimum 512 MB SDRAM and 2 GB SODIMM 

Screen: EGA/VGA XGA/ VGA 

CD ROM: Internal, 24X None 

Ethernet: 10/100 Base-T Ethernet network 
connectivity 

10/100 Base-T Ethernet network 
connectivity 

USB ports: 4 ports, USB 1.1, which support 
USB 1.1 components 

4 ports, USB 2.0, which support 
USB 1.1/2.0 components 

DIMENSIONS AND WEIGHT OF THE OTHER COMPONENTS 

Main module: Length: 24 in. (61 cm) 
Width: 10 in. (25.4 cm) 
Height: 10 in. (25.4 cm) 
Weight: 40 lb (18.14 kg) 

Load cell:  Length: 13 in. (33 cm) 
Width: 8 in. (20.3 cm) 
Height: 10 in. (25.4 cm) 
Weight: 5 lb (2.3 kg) 

Base plate:  Weight: 13 lb (5.89 kg)  

Compounder (including the main 
module, base plate and display) 
without vial rack: 

Length: 30 in. (76.2 cm) 
Width: 19 in. (48.3 cm) 
Height: 12 in. (30.5 cm) 
Weight: 79 lb (35.83 kg) 

Compounder (including the main 
module, base plate and display) 
with vial rack: 

Length: 41 in. (104.1 cm) 
Width: 20 in. (50.8 cm) 
Height: 30 in. (76.2 cm) 
Weight: 88.5 lb (40.14 kg) 

ELECTRICAL  

Power:  100–240 V AC RMS, 50–60 Hz, 336 W 

Line cord: 3-prong detachable plug, hospital grade 

Fuse ratings: 

 Pump driver PCA 

 LRV PCA 

 Power supply 

F1—3 Amp, 2 AG, fast acting, 250 V 
F1—2 Amp, 2 AG, fast acting, 250 V 
F1—4 Amp, 5 x 20 mm, slow acting, 250 V 
F2—4 Amp, 5 x 20 mm, slow acting, 250 V 
F3—3.15 Amp, 5 x 20 mm, fast acting, 250 V 
F4—3.15 Amp, 5 x 20 mm, fast acting, 250 V 
F5—6.3 Amp, 5 x 20 mm, fast acting, 250 V 
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PERFORMANCE 

Accuracy: ± 10% at 0.2 mL 
± 5% at 0.4 mL 
± 3% above 1 mL 

Dispensing of ingredients: Increments of 0.01 mL 

Volume of source containers: 0.2–5,500 mL 

Volume of destination bags: 125–5,000 mL 

Maximum flow rate of water: 16.6 mL/second 

Maximum number of ingredients: 24 

Maximum capacity of vial rack: 16 (small-volume vials and 60 mL Luer syringes) 

ENVIRONMENTAL 

Operating temperature: 59–86°F (15–30°C) 

Storage temperature:  32–147°F (0–64°C) 

Maximum relative humidity:  10–80% 

Maximum altitude:  Not to exceed 3,000 m 

Main supply voltage fluctuation:  Not to exceed ±10% (surge protection recommended) 

Sound pressure level: Not to exceed 85 dBA 

For Indoor Use Only 

ISO Class 5 (Class 100) cleanroom as defined in ISO 14644-1:1999 

Class I Equipment (Grounded Type) 

Installation (Over Voltage) Category II 

Pollution Degree 2 Environment 

The maximum circuit voltage of USB 1.1/2.0 is 5.0 V DC with a maximum current of 500 mA DC 
(all ports combined). Use only USB devices supplied by Baxa Corporation. 

For EMC compliance, ferrite beads are required on these cables: 

 Display cable (on the DX display only) 

 USB A to B printer cable 

 Ethernet cable 

NOTE: Ferrite beads are attached by Baxa Corporation. There are no internal user-serviceable 
parts. 
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APPENDIX B: POLICIES AND PROCEDURES 

TRANSFERRING PATIENT (.PAT) FILES TO THE EXACTAMIX 
COMPOUNDERS WHEN THE NETWORK IS UNAVAILABLE 

Policy 

Patient (.PAT) files are prepared with ABACUS Software on the order-entry computer, then 
transferred electronically to a directory for use on the compounder. PAT files may be 
transferred through peer-to-peer transfer, or by having the two software modules address a 
common directory path on the network. 

When the network connection is unavailable, users must have a way to retrieve .PAT files from 
the order-entry computer and load them onto the compounder. In this situation, follow the 
steps below to transfer .PAT files by using a USB drive. 

Equipment 

 Order-entry computer with ABACUS Software installed 

 USB drive 

Procedure 

On the order-entry computer: 

1. Connect the USB drive to the USB port. 

NOTE: The ABACUS Software must be set to save the .PAT file to the USB drive. If you 
need assistance, contact Baxa Corporation Technical Support. Refer to Getting Help on 
Page 17. 

2. Select Tools > Options > Directories. 
3. Change the directory for the formulas to the location of the USB drive. You can use the 

Browse button to browse to the USB drive. 

The software requires you to reboot the computer.  

4. Continue with Loading a Formula by Connecting a USB Drive on Page 196. 

NOTE: Formulas saved to the USB drive are available for either barcode scanning or 
manual selection. 
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FILLING EVACUATED CONTAINERS FOR USE WITH THE EXACTAMIX 
COMPOUNDERS 

Policy 

Users should always follow this procedure to fill evacuated containers that will be used with the 
compounder. 

Equipment 

 Two 60 cc syringes 

 150 mL evacuated container(s) 

 EXACTAMED Dispensing Pin(s) (Order No. H93847) 

 Vented Micro-Volume Inlet (Order No. H938175)  

 EXACTAMIX 1200/2400 Compounder 

Procedure 

1. Pull the prepared solution into a 60 cc syringe. 
2. Open the evacuated container. 
3. Swab the container with alcohol. 
4. Insert the dispensing pin all the way into the container. 

The pressure equalizes. 

5. Remove the cap from the dispensing pin. 
6. Attach an empty 60 cc syringe to the dispensing pin. 
7. Invert the container. 
8. Remove the residual liquid from the container. 

NOTE: The container must be fully inverted to extract as much liquid as possible. 

9. Detach the syringe from the dispensing pin. If you will fill multiple containers, retain the 
syringe for use with the other containers. 

10. Attach the syringe with the prepared solution to the dispensing pin. 
11. Dispense the solution into the container. 
12. Remove the syringe from the dispensing pin and add solution from additional syringes 

until the desired volume is reached. 
13. Remove the syringe and the dispensing pin. 

The container is ready to be spiked and attached to the inlet on the compounder. 

NOTE: When spiking a container, enter into the original puncture. 
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Inserting the dispensing pin  
and removing residual liquid 
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LABELING SOURCE CONTAINERS FOR USE WITH THE EXACTAMIX 
COMPOUNDERS 

Policy 

All source containers for the compounder should be labeled with barcodes before they are 
placed in the admixture area. Containers that have a manufacturer’s barcode do not need 
additional labeling. 

Equipment 

 EXACTAMIX 1200/2400 Compounder 

 Self-adhesive labels (Avery 5160 label sheets are recommended.) 

 Printer 

Procedure 

Before attaching new ingredients to the compounder: 

1. Gather all the new ingredients. 

Tip! Baxa Corporation recommends using the Authorization Report to quickly identify 
the ingredients needed for a specific configuration. Refer to Authorization Report on 
Page 159. 

2. Check that each source container has a barcode label attached. 

Tip! Baxa Corporation strongly recommends using the manufacturer’s barcode labels 
whenever possible. 

3. If a container that was filled or diluted in the pharmacy does not have a barcode label: 
a. Print the appropriate label. Refer to Product Bar Codes Report on Page 168. 
b. Apply the label.  

NOTE: To minimize curvature of the barcode, the preferred application is vertical; 
however, labels may be applied horizontally to bags and large bottles. 

Tip! When all containers are labeled, Baxa Corporation recommends that a pharmacist 
perform a final verification. 

4. If desired, a pharmacist does the following steps: 
a. Perform a final check of each container. 
b. Initial each label to show that it was checked and found to be correctly applied. 
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VALIDATING ASEPTIC TECHNIQUE WITH THE EXACTAMIX 
COMPOUNDERS 

Policy 

This procedure monitors the quality of the aseptic technique used by employees at the 
compounder. This procedure should be conducted: 

 As often as necessary to comply with USP 797 

 For each employee who uses the EXACTAMIX Compounder 

 Before the first bag of the day (immediately after daily setup) and after the last bag of 
the day, to validate that users followed good technique during the daily setup and 
throughout the day 

Equipment 

 EXACTAMIX 1200/2400 Compounder, set up with the daily configuration 

 Q.I. Medical QT1000 QuickTest™ System 

Procedure 

IMPORTANT! During this procedure, an additional 10 mL of each ingredient is pumped from 
each source container, except for the Universal Ingredient (UI). You must include this additional 
volume when attaching the ingredients, especially those ingredients in syringes. 

1. Remove and aseptically save the cover of the QT1000 non-vented spike. 
2. Aseptically insert the spike into the outlet tube of the valve set on the compounder. 
3. Remove and aseptically save the cover from the distal end of the spike. 
4. Attach the spike to a Baxa bag.  

Tip! Baxa Corporation recommends that this bag be appropriately labeled and marked 
“Not for Human Use.” The bag should be discarded immediately after use. 

5. Attach the bag to the load cell. Refer to Attaching and Removing the Calibration Bag on 
Page 43. 

NOTE: A user with Formula Entry permissions must log on and do the following steps. 

6. Through direct entry, create a formula that uses all the ingredients that are attached to 
the compounder. Refer to Entering a Formula Through Direct Entry on Page 74. Enter at 
least 10 mL for each ingredient and 30 mL for the Universal Ingredient (UI). 

7. Touch the Menu button. 
8. At the menu screen, select File > Save Formula As. 
9. Name the formula Aseptic Technique Validation or a similar name that is appropriate 

for your facility. 
10. Touch OK. 

The pump screen appears. 

11. Compound the solution and follow the directions for use with the QT1000 system. 
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12. File the MixCheck Report and the QuickTest logs in the “Records” section of the Baxa 
USP 797 Compliance Package. 

13. When this procedure is conducted before the first bag of the day: 
a. Cancel direct entry. 
b. Have the normal user log on and continue with normal compounding. 

INSTALLING THE VALVE SET ON THE EXACTAMIX COMPOUNDERS 

Policy 

Compounder tube sets should be replaced at the beginning of the work day, at intervals 
established by the pharmacy. Baxa recommends intervals of 24 hours. The compounder and 
adjacent work area should be cleaned before a new tube set is installed. 

Equipment 

 EXACTAMIX 1200/2400 Compounder  

 EM1200 Valve Set (Order No. H938792) 

 EM2400 Valve Set (Order No. H938724) 

NOTE: The valve set is a sterile, 12- or 24-port valve with an outlet tube attached. The 
valve body fits over the valve actuators on the compounder, protecting them from 
damage. The outlet tube attaches to the destination bag. Inlets must be purchased 
separately. 

Procedure 

 

CAUTION 

If the valve set is not installed correctly, the compounder cannot be calibrated 
accurately. 

1. Check that the valve actuators are not broken or damaged. 

 

Valve actuators 

 

Normal 

 

Damaged 

 

Broken 

 

WARNING 

Do not use the compounder if a valve actuator is broken or damaged. Patient 
harm may result. For assistance, contact Baxa Corporation Technical Support. 
Refer to Getting Help on Page 17. 
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2. Using aseptic technique, remove the valve set from the packaging.  
3. Check that all the slots on the bottom of the valve set are aligned. 
4. Place the valve set onto the valve actuators.  
5. Gently push the end tabs down and out until you hear a click on each end. 

 

Installing the12-port valve set 

 

Installing the24-port valve set 

NOTE: The appearance of the valve set may differ from the examples shown above. 

6. Make sure that the valve set is installed securely by pulling up on both ends gently. 

 

CAUTION 

Once the valve set has been installed, do not attempt to remove it during 
operation. 

7. Open the pump door. 
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WARNING 

To avoid pinching your fingers, grasp the pump rotor from the top and rotate it 
counterclockwise, keeping your fingers away from other surfaces while moving 
the rotor. 

 

 

CAUTION 

Do not pull or stretch the outlet tube. 

8. Route the outlet tube into channel 1, around the pump rotor and into channels 2 and 3 
as shown. Move the pump rotor counterclockwise only. 

 

Routing the outlet tube 

a. Make sure that the tube is in correct position at the bottom of channels 1 and 2. 

 

Correct position 

 

Incorrect position 

b. Make sure that the tube is in correct position against the wall around the pump 
rotor. 

 

Correct position 

 

Incorrect position 

Pump rotor Outlet tube in channel 1 

Channel 3 Channel 2 
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9. Close the pump door. 
10. Connect the end of the outlet tube to the tube holder on the vial rack. 

 

Connecting the outlet tube 
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APPENDIX C: COMMON ISSUES 

If you encounter any of these issues, take the suggested actions. If the issue persists, contact 
Baxa Corporation Technical Support. Refer to Getting Help on Page 17. 

For more information about interruptions that may occur as part of normal operation, refer to 
Fulfilling the Order (Additional Steps) on Page 87. For more information about errors, refer to 
Troubleshooting on Page 183.  

ATTACHING AN INCORRECT PATIENT BAG 

 

WARNING 

If you scan the barcode label on one patient bag, become distracted and then attach a 
different patient bag to the load cell, patient harm may result. 

Always attach the patient bag to the load cell before scanning the barcode on the label of the 
bag. For more information about attaching a patient bag, refer to Attaching the Patient Bag on 
Page 72. 

 

Correct technique 

 

Incorrect technique 
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BARCODE READER: FORMULA NOT FOUND 

If an issue such as a network connectivity problem prevents the compounder from finding or 
accessing the formula file, this message appears: Barcode reader (<serial number of .PAT file>): 
formula not found. 

 

Message 

To resolve the issue: 

1. Correct the .PAT file in the order-entry software. 
2. Reprint and attach the barcode label. 
3. Scan the barcode again. 
4. Check that the Ethernet cable is connected correctly to both the display and the order-

entry computer. 
5. Check that the network is functioning. 
6. Check the path on both the order-entry computer and the compounder. Refer to Setting 

Up the Directories Options on Page 119. 
7. Reboot the compounder. Refer to Rebooting and Shutting Down on Page 29. 
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ISSUES WITH THE FORMULAS, INGREDIENTS AND CONFIGURATIONS 

Incompatible Ingredients with Insufficient Flush Volume 

If a formula contains incompatible ingredients with an insufficient flush volume between them, 
this Formula Conflict message appears: Formula contains incompatible ingredients with 
insufficient flush volume between them. The message indicates which ingredients are 
incompatible. 

 

Message 

To resolve the issue: 

1. Touch Cancel. 
2. Contact Baxa Corporation Technical Support. Refer to Getting Help on Page 17. 
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Additional Universal Ingredient (UI) Required for Flush 

If a formula does not contain the minimum required volume of the Universal Ingredient (UI), 
which is necessary for flushing the fluid pathway, this Formula Conflict message appears: 
Additional <flush volume> mL of <Universal Ingredient> required for order. The message 
indicates how much additional volume is needed. The user can either change the Universal 
Ingredient (UI) or cancel the order. 

 

Message 

To resolve the issue: 

IMPORTANT! This function requires Change Universal Ingredient permissions. For more 
information about user groups and permissions, refer to Setting Up the Users on Page 121.  

1. Touch Change UI To…  
2. Touch OK. 

A Change Universal window appears. It lists any ingredients that are specified as a UI in 
the Formulary Editor (refer to Adding or Editing an Ingredient on Page 139), included at 
a UI port in the configuration (refer to Adding or Editing a Configuration on Page 130) 
and have an ordered volume that is sufficient for a UI. 

3. At the Change Universal window: 
a. Select the Universal Ingredient you want to use. 
b. Touch OK. 

 

Change Universal window 
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WARNING 

Do not use a patient bag during Universal Ingredient flushes. Otherwise, the 
patient bag may contain an unintended volume and/or ingredient, resulting in 
patient harm. 

4. If a patient bag is attached, remove it. Refer to Removing the Patient Bag on Page 86. 

 

Removing the patient bag 

5. Attach a calibration bag. Refer to Attaching and Removing the Calibration Bag on 
Page 43. 

 

Attaching the calibration bag 

6. At the Flushing with Universal Ingredient message, touch OK.  
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The calibration bag fills. 

 

Filled calibration bag 

 

WARNING 

Do not touch OK at the Completed flushing message until after you attach the 
patient bag. Otherwise, the compounder will pump the formula ingredients into 
the calibration bag. 

7. When the Completed flushing message appears, remove the calibration bag. Refer to 
Attaching and Removing the Calibration Bag on Page 43. 

8. Attach the patient bag. Refer to Attaching the Patient Bag on Page 72. 
9. At the Completed flushing message, touch OK. 

 

Completed flushing message 

10. Repeat the compounding process. 
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Calibration Ingredient Not Found in Configuration 

A Calibration ingredient not found in configuration message most often appears when the 
calibration ingredient (for example, the manufacturer or container size of dextrose), has 
changed recently. 

 

Message 

To resolve the issue: 

1. Check that the calibration ingredient is set correctly. Refer to Setting the Calibration 
Ingredient on Page 141. 

2. If it is set correctly, contact Baxa Corporation Technical Support for assistance. Refer to 
Getting Help on Page 17. 
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ISSUES WITH THE CALIBRATION 

Span Calibration Out of Range 

If something touches or interferes with the load cell during its calibration, this message 
appears: Span Calibration Out Of Range. Calibration failed. 

 

Message 

To resolve the issue: 

1. Check that: 

 The cable for the load cell is connected correctly. 

 The load cell is level and locked into place. 

 There is nothing (for example, the outlet tube, bag or cable for the load cell) 
touching the pan or base of the load cell. 

 There are no environmental factors (for example, air flow or vibrations) interfering 
with the load cell. 

2. Calibrate the load cell. Refer to Calibrating the Load Cell on Page 33. Read the on-screen 
messages carefully, and make sure that you do not place the calibration weight on the 
load cell too early. 
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Unable to Measure Stable Weight 

If something touches or interferes with the load cell during calibration of the compounder, this 
message appears: Unable to measure stable weight. 

 

Message 

To resolve the issue: 

1. Check that:  

 The load cell is level and locked into place. 

 There is nothing (for example, the outlet tube, bag or cable for the load cell) 
touching the pan or base of the load cell. 

 There are no environmental factors (for example, air flow or vibrations) interfering 
with the load cell. 

2. Calibrate the compounder. Refer to Calibrating the Compounder on Page 67. 
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Pump Calibration Has Failed 

If calibration of the pump fails, this message appears: Pump calibration has failed. 

 

Message 

To resolve the issue: 

1. Check that the valve set is installed correctly. Refer to Installing the New Valve Set on 
Page 41. 

2. For the source container of water, check the following conditions. Refer to Attaching the 
New Ingredients and Inlets on Page 45. 

 The correct inlet is used. 

 The inlet is not kinked. 

 The bag is spiked correctly. Refer to Page 49. 

3. Clean any spills near the pump rotor. 
4. Calibrate the load cell. Refer to Calibrating the Load Cell on Page 33. 
5. Calibrate the pump. Refer to Calibrating the Compounder on Page 67. 
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ISSUES WITH THE WEIGHT AND LOAD CELL 

Weight Outside of the Acceptable Limit 

When compounding is finished, a message displays this information about the patient bag: 

 Expected weight 

 Actual weight 

 Difference 

 Whether the difference is outside of the acceptable limit of +/-5% 

The message also lists any individual ingredients that are over 100 mL and have a weight 
difference outside of the acceptable limit of +/-5%. 

 

Message 

If the final bag weight is out of range, to resolve the issue:  

1. On the MixCheck Report, check for suspect ingredients and references to occlusions and 
bubbles. Refer to MixCheck Report on Page 154.  

2. Calibrate the load cell. Refer to Calibrating the Load Cell on Page 33. 
3. Calibrate the compounder. Refer to Calibrating the Compounder on Page 67. 
4. If the issue persists, check that: 

 All the source containers are spiked correctly. Refer to the steps for spiking a 
container, starting on Page 49. 

 The rollers on the pump rotor are clean and move freely. Refer to Cleaning the 
Compounder on Page 100. 

 The tube set is installed correctly. Refer to Attaching the New Ingredients and Inlets 
on Page 45. 

5. Compound a large-volume solution with at least 205 mL of water to make the 
compounder calibrate automatically. 
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Bag Does Not Appear to Be Empty 

In most cases, when you touch Run to fulfill an order, the compounder expects an empty 
delivery bag. If the compounder detects that the delivery bag is not empty, this message 
appears: Bag currently on the load cell does not appear to be empty. Continue?  

This message may appear when the user changes the Universal Ingredient (UII) and forgets to 
replace the patient bag with a calibration bag. 

 

Message 

 

WARNING 

If you touch Yes, the compounder will reset the measured weight to zero, despite the 

fact that the bag contains fluid.  

The finished solution may contain an unintended volume or ingredient, even if the final 
measured weight is within the acceptable range. This unintended volume or ingredient 
may result in patient harm. 

The Details section of the MixCheck Report will indicate that you continued 
compounding despite the warning that the bag did not appear to be empty. 

This bag should be discarded. 

 

MixCheck Report with “Overrode destination bag not empty warning” 
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Do not continue until the issue is resolved. To resolve the issue, visually check the contents of 
the bag. 

If the bag contains fluid: 

1. Touch No. 
2. At the Operation Cancelled message, touch OK. 
3. If the attached bag is a patient bag, write a large “X” on the label. 
4. Remove the bag from the load cell. Depending on the type of the attached bag, refer to: 

 Removing the Patient Bag on Page 86 

 Attaching and Removing the Calibration Bag on Page 43 

5. Discard the bag. 
6. Attach an empty patient bag. Refer to Attaching the Patient Bag on Page 72. 

If the bag is empty: 

1. Touch No. 
2. At the Operation Cancelled message, touch OK. 
3. Remove the bag from the load cell. Depending on the type of the attached bag, refer to: 

 Removing the Patient Bag on Page 86 

 Attaching and Removing the Calibration Bag on Page 43 

4. Calibrate the load cell. Refer to Calibrating the Load Cell on Page 33. 
5. If necessary, attach the appropriate bag to the load cell. Refer to: 

 Attaching the Patient Bag on Page 72 

 Attaching and Removing the Calibration Bag on Page 43 
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ISSUES WITH THE PUMP 

During the pumping process, errors may occur due to issues such as incorrect positioning of the 
outlet tube around the pump rotor, manual adjustments made to the rotor or use of a dirty 
rotor. 

Pump Door Was Opened 

If you need to stop compounding temporarily, you can touch Pause or open the pump door. 

 

Opening the pump door 

Compounding stops and this message appears: Pump door was opened. 

 

Message 
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NOTE: When the pump door is opened, this event will be logged in the Details section of the 
MixCheck Report. 

 

MixCheck Report with “Pump door was open” message 

To resolve the issue: 

1. Close the pump door. 
2. Touch OK. 
3. Touch Resume to continue compounding. 

Pump Is Faulted 

If the pump door is opened, this message may also appear: Pump is faulted. 

 

Message 

To resolve the issue: 

1. Close the pump door. 
2. Touch OK. 
3. Touch Resume to continue compounding. 
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Unable to Start the Pump 

If the rotor is manually adjusted while the compounder is turned on, this message appears: 
Unable to start the pump because the pump is in a fault state. 

 

Message 

To resolve the issue: 

1. Touch OK. 
2. At the pump screen, touch Stop and follow the on-screen instructions. 
3. Reboot the compounder. Refer to Rebooting and Shutting Down on Page 29. 
4. Repeat the compounding process. 
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INTERRUPTIONS 

Air Bubble 

An air bubble can occur at any time, but it most frequently occurs after priming the inlet during 
setup or after replacing a source container. A bubble can be caused by an incorrectly spiked 
container, an empty container or incomplete priming. 

When the bubble detector finds a bubble in the outlet tube over the detector, the 
compounding process stops and an alarm beeps. A message also appears. To resolve the issue: 

1. At the Bubble was detected while pumping from port <port number> message, 
touch OK. 

 

Message 

 

WARNING 

A bubble in the common fluid pathway displaces the volume of one or more 
ordered ingredients, causing an under-delivery of these ingredients. 

2. Determine the impact of the bubble:  
a. Check the size of the bubble using the EM2400 Bubble Chart (5300-0868) to 

determine the volume of fluid displaced. 
b. If more than one bubble is present, evaluate each bubble and add the values 

together to determine the total volume of fluid displaced. 
c. Identify all the ingredients pumped prior to the alarm, the ingredient pumped 

during the alarm and the volume of each ingredient ordered. 

 

Using the EM2400 Bubble Chart 

Tip! Baxa Corporation recommends that a pharmacist evaluate the clinical significance 
of bubbles encountered during the compounding process. 
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3. Ask a pharmacist to determine if the displaced volume is clinically significant for any of 
the ingredients pumped. Assume that the total displaced volume applies to each 
ingredient ordered. 

4. If the clinical significance: 

 Is acceptable, touch Resume at the pump screen to continue compounding the 
solution, and do not continue with the steps below 

 Is not acceptable, or cannot be determined, continue with the next step to cancel 
the order 

Tip! Baxa Corporation recommends documenting all decisions according to your 
facility’s protocol. 

5. Immediately write a large “X” on the label of the patient bag.  
6. At the pump screen, touch Stop. 
7. At the Really abort the current solution? message, touch Yes.  

 

Message 

The software unloads the formula. 

8. At the Operation Cancelled message, touch OK. 

 

Message 
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9.  At the Fluid path will be flushed with UI message, touch OK. 

 

Message 

10. Check that the fluid moves correctly during the flush. 
11. At the UI flush complete message, touch OK. 

 

Message 

12. Remove the bag. Refer to Removing the Patient Bag on Page 86. 
13. Discard the bag. 

NOTE: To help reduce the occurrence of bubbles: 

 Use correct technique to spike the containers. Refer to the steps for spiking a container, 
starting on Page 49. 

 Re-prime any inlets that have visible bubbles. Refer to Priming the Inlets and Verifying 
the Setup on Page 59. 

 Increase the priming volume in the configuration. Refer to Adding or Editing a 
Configuration on Page 130. 

NOTE: To help avoid false bubble detections:  

 Clean the channel over the bubble detector. Refer to Cleaning the Compounder on 
Page 100. 

 Make sure that the outlet tube is in the correct position. It should be at the bottom of 
the channel over the bubble detector. Refer to Step 8a on Page 42. 
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Occlusion 

An occlusion can be caused by an empty syringe, stuck syringe plunger, kinked tube or other 
obstruction in the inlet. 

When the occlusion detector detects that a vacuum was drawn, indicating an occlusion 
somewhere between the source container and the detector, the compounding process stops 
and an alarm beeps. A message appears, and a red occlusion symbol also appears near the 
ingredient button. To resolve the issue: 

 

Occlusion symbol 

1. Immediately write a large “X” on the label of the patient bag. 
2. At the Occlusion was detected while pumping from port <port number> message, 

touch OK. 

  

Message 

3. At the pump screen, touch Stop. 
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4. At the Really abort the current solution? message, touch Yes.  

 

Message 

The software unloads the formula. 

5. At the Operation Cancelled message, touch OK. 

 

Message 

6. Check that: 

 The outlet tube is straight and flat on the occlusion detector. 

 The occlusion detector is not damaged or dirty. 

 The inlets have no obstructions, kinks or tangles. If necessary, replace the inlets. 
Refer to Changing the Tube Set on Page 38. 

 The appropriate inlet is used with each source container. 

 Each syringe has fluid and its plunger is not stuck. 
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NOTE: If you cannot find the cause for the occlusion, contact Baxa Corporation Technical 
Support. Refer to Getting Help on Page 17. 

7. At the Fluid path will be flushed with UI message, touch OK. 

 

Message 

8. Check that the fluid moves correctly during the flush. 
9. At the UI flush complete message, touch OK. 

 

Message 

10. Remove the bag. Refer to Removing the Patient Bag on Page 86. 
11. Discard the bag. 
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APPENDIX D: TRADEMARK AND WARRANTY STATEMENTS 

TRADEMARK STATEMENT 

The following are registered trademarks of Baxa Corporation: Baxa, the Baxa logo, ABACUS, 
DoseEdge and EXACTAMIX. 

MIXCHECK is a trademark of Baxa Corporation. 

WARRANTY STATEMENT 

Baxa Corporation provides a limited warranty for the EXACTAMIX 2400 Compounder. 

See your lease or purchase contract for details about the warranty. 

If the equipment is under warranty, Baxa Corporation will replace the defective equipment the 
day following notification, whenever possible. Equipment that is not under warranty can also 
be replaced the next day. The customer is responsible for the cost of repairs and shipping. 

Baxa Corporation warrants that the EXACTAMIX 2400 Operating Software will perform as 
described in the operator manual, by the release notes with the currently released version and 
when operated on a correctly configured computer using a correctly configured load cell and 
barcode reader. Where there is a discrepancy between the manual and the operation of the 
software, Baxa Corporation may, at its discretion, revise either the software or the text of the 
manual. 

This software is intended solely for the operation of the EXACTAMIX 2400 Compounder for the 
preparation of compounded sterile formulas. It is not intended to replace the professional 
knowledge or judgment of a Registered Pharmacist in the preparation of such formulas. 

No other warranties, whether express or implied, made by any representative or other agent of 
Baxa Corporation shall be binding upon Baxa Corporation. This is an exclusive warranty. 



Corporate Headquarters, USA
Baxa Corporation
Englewood, CO 80112  |  tel: 303.690.4204
fax: 303.690.4804  |  toll free: 800.567.BAXA (2292)
www.baxa.com  |  email: baxamail@baxa.com

Registered Agent, United Kingdom
Baxa Ltd
Bracknell, RG12 2UP  |  tel: +44 (0)1344 392902
fax: +44 (0)1344 392903  |  email: info@baxa.co.uk

To find a local Baxa agent,  
visit our website at www.baxa.com 
or call our offices directly.

The following are registered trademarks of Baxa Corporation: 
Abacus, Baxa, the Baxa logo, DoseEdge and ExactaMix.

MixCheck is a trademark of Baxa Corporation.
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